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Install and configure SnapCenter Server

Prepare for installing the SnapCenter Server

Requirements to install SnapCenter Server

Before you install SnapCenter Server either on Windows or Linux host, you should review

and ensure that all the requirements are met for your environment.

Domain and workgroup requirements for Windows host

The SnapCenter Server can be installed on a Windows host that is either in a domain or in a workgroup.

The user having admin privileges is allowed to install the SnapCenter server.

• Active Directory domain: You must use a Domain user with local administrator rights. The Domain user

must be a member of the local Administrator group on the Windows host.

• Workgroups: You must use a local account that has local administrator rights.

While domain trusts, multi-domain forests, and cross-domain trusts are supported, cross-forest domains are

not supported. The Microsoft documentation about Active Directory Domains and Trusts contains more

information.

After installing the SnapCenter Server, you should not change the domain in which the

SnapCenter host is located. If you remove the SnapCenter Server host from the domain it was

in when the SnapCenter Server was installed and then try to uninstall SnapCenter Server, the

uninstall operation fails.

Space and sizing requirements

You should be familiar with the space and sizing requirements.

Item Windows host requirements Linux host requirements

Operating Systems Microsoft Windows

Only English, German, Japanese,

and simplified Chinese version of

the operating systems are

supported.

For the latest information about

supported versions, see NetApp

Interoperability Matrix Tool.

• Red Hat Enterprise Linux

(RHEL) 8 and 9

• SUSE Linux Enterprise Server

(SLES) 15

For the latest information about

supported versions, see NetApp

Interoperability Matrix Tool.

Minimum CPU count 4 cores 4 cores
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Item Windows host requirements Linux host requirements

Minimum RAM 8 GB

The MySQL Server

buffer pool uses 20

percent of the total

RAM.

8 GB

Minimum hard drive space for the

SnapCenter Server software and

logs

7 GB

If you have the

SnapCenter

repository in the

same drive where

SnapCenter Server

is installed, then it is

recommended to

have 15 GB.

15 GB

Minimum hard drive space for the

SnapCenter repository

8 GB

NOTE: If you have

the SnapCenter

Server in the same

drive where

SnapCenter

repository is

installed, then it is

recommended to

have 15 GB.

Not applicable

Required software packages • ASP.NET Core Runtime 8.0.12

(and all subsequent 8.0.x

patches) Hosting Bundle

• PowerShell 7.4.2 or later

For .NET specific troubleshooting

information, see SnapCenter

upgrade or install fails for legacy

systems that do not have internet

connectivity.

• .NET Framework 8.0.12 (and

all subsequent 8.0.x patches)

• PowerShell 7.4.2 or later

• Nginx is a web server that can

be used as a reverse proxy

• Pam-devel

PAM (Pluggable Authentication

Modules) is a system security

tool which allows system

administrators to set

authentication policy without

having to recompile programs

which do authentication.
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ASP.NET core needs IIS_IUSRS to access the temp file system in SnapCenter Server on

Windows.

SAN host requirements

SnapCenter does not include host utilities or a DSM. If the SnapCenter host is part of a SAN (FC/iSCSI)

environment, you might need to install and configure additional software on the SnapCenter Server host.

• Host Utilities: The Host Utilities support FC and iSCSI, and it enables you to use MPIO on your Windows

Servers. Learn More.

• Microsoft DSM for Windows MPIO: This software works with Windows MPIO drivers to manage multiple

paths between NetApp and Windows host computers. A DSM is required for high availability

configurations.

If you were using ONTAP DSM, you should migrate to Microsoft DSM. For more information,

see How to migrate from ONTAP DSM to Microsoft DSM.

Browser requirements

SnapCenter software supports Chrome 125 and later and Microsoft Edge 110.0.1587.17 and later.

Port requirements

The SnapCenter software requires different ports for communication between different components.

• Applications cannot share a port.

• For customizable ports, you can select a custom port during installation if you do not want to use the

default port.

• For fixed ports, you should accept the default port number.

• Firewalls

◦ Firewalls, proxies, or other network devices should not interfere with connections.

◦ If you specify a custom port when you install SnapCenter, you should add a firewall rule on the plug-in

host for that port for the SnapCenter Plug-in Loader.

The following table lists the different ports and their default values.
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Port Name Port Numbers Protocol Direction Description

SnapCenter web

port

8146 HTTPS Bidirectional This port is used for

communication

between the

SnapCenter client

(the SnapCenter

user) and the

SnapCenter Server

and is also used for

communication from

the plug-in hosts to

the SnapCenter

Server.

You can customize

the port number.

SnapCenter

SMCore

communication port

8145 HTTPS Bidirectional This port is used for

communication

between the

SnapCenter Server

and the hosts where

the SnapCenter

plug-ins are

installed.

You can customize

the port number.

Scheduler Service

Port

8154 HTTPS This is port is used

to orchestrate the

SnapCenter

scheduler workflows

for all the managed

plug-ins within the

SnapCenter server

host in centralized

manner.

You can customize

the port number.

RabbitMQ Port 5672 TCP This is the default

port that RabbitMQ

listens on and it is

used for publisher-

subscriber model

communication

between Scheduler

service and

SnapCenter.
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Port Name Port Numbers Protocol Direction Description

MySQL port 3306 HTTPS The port is used for

communicating with

SnapCenter

repository database.

You can create

secured connections

from the

SnapCenter Server

to the MySQL

server. Learn more

Windows plug-in

hosts

135, 445 TCP This port is used for

communication

between the

SnapCenter Server

and the host on

which the plug-in is

being installed.

Additional dynamic

port range specified

by Microsoft should

also be open.

Linux or AIX plug-in

hosts

22 SSH Unidirectional This port is used for

communication

between the

SnapCenter Server

and the host,

initiated from the

server to client host.

SnapCenter Plug-ins

Package for

Windows, Linux or

AIX

8145 HTTPS Bidirectional This port is used for

communication

between SMCore

and hosts where the

plug-ins package is

installed.

Customizable.

You can customize

the port number.

SnapCenter Plug-in

for Oracle Database

27216 The default JDBC

port is used by the

plug-in for Oracle for

connecting to the

Oracle database.
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Port Name Port Numbers Protocol Direction Description

SnapCenter Plug-in

for Exchange

Database

909 The default

NET.TCP port is

used by the plug-in

for Windows for

connecting to the

Exchange VSS call-

backs.

NetApp supported

plug-ins for

SnapCenter

9090 HTTPS This is an internal

port that is used only

on the plug-in host;

no firewall exception

is required.

Communication

between the

SnapCenter Server

and plug-ins is

routed through port

8145.

ONTAP cluster or

SVM communication

port

• 443 (HTTPS)

• 80 (HTTP)

• HTTPS

• HTTP

Bidirectional The port is used by

the SAL (Storage

Abstraction Layer)

for communication

between the host

running SnapCenter

Server and SVM.

The port is currently

also used by the

SAL on SnapCenter

for Windows Plug-in

hosts for

communication

between the

SnapCenter plug-in

host and SVM.

SnapCenter Plug-in

for SAP HANA

Database

•

3instance_numb

er13

•

3instance_numb

er15

• HTTPS

• HTTP

Bidirectional For a multitenant

database container

(MDC) single tenant,

the port number

ends with 13; for

non MDC, the port

number ends with

15.

You can customize

the port number.
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Port Name Port Numbers Protocol Direction Description

SnapCenter Plug-in

for PostgreSQL

5432 This port is the

default PostgreSQL

port used for

communication by

the plug-in for

PostgreSQL to the

PostgreSQL cluster.

You can customize

the port number.

Register to access the SnapCenter software

You should register to access the SnapCenter software if you are new to Amazon FSx for

NetApp ONTAP or Azure NetApp Files and do not have an existing NetApp account.

Before you begin

• You should have access to the corporate email ID.

• If you using Azure NetApp Files, you should have the Azure subscription ID.

• If you are using Amazon FSx for NetApp ONTAP, you should have the File System ID of your FSx for

ONTAP file system.

About this task

Your registration is subject to information validations and may take up to a day to confirm and upgrade new

NetApp Support Site (NSS) account to full access from guest access.

Steps

1. Click https://mysupport.netapp.com/site/user/registration for registration.

2. Enter your corporate email ID, complete the captcha, accept NetApp’s privacy policy, and click Submit.

3. Authenticate the registration by entering the OTP sent to your email ID and click Continue.

4. On the registration completion page, enter the following details to complete the registration.

a. Select NetApp Customer / End User.

b. In the SERIAL NUMBER field, either enter the Azure subscription ID if you are using Azure NetApp

Files or the File System ID if you are using Amazon FSx for NetApp ONTAP.

You can raise a ticket at https://mysupport.netapp.com/site/help if you face any issue during

registration or to know the status.

Multi-factor authentication (MFA)

Manage multi-factor authentication (MFA)

You can manage Multi-factor authentication (MFA) functionality in the Active Directory

Federation Service (AD FS) Server and SnapCenter Server.
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Enable multi-factor authentication (MFA)

You can enable MFA functionality for SnapCenter Server using PowerShell commands.

About this task

• SnapCenter supports SSO based logins when other applications are configured in the same AD FS. In

certain AD FS configurations, SnapCenter might require user authentication for security reasons

depending on the AD FS session persistence.

• The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also see SnapCenter Software

Cmdlet Reference Guide.

Before you begin

• Windows Active Directory Federation Service (AD FS) should be up and running in the respective domain.

• You should have an AD FS supported Multi-factor authentication service such as Azure MFA, Cisco Duo,

and so on.

• SnapCenter and AD FS server timestamp should be the same regardless of the timezone.

• Procure and configure the authorized CA certificate for SnapCenter Server.

CA Certificate is mandatory for the following reasons:

◦ Ensures that the ADFS-F5 communications do not break because the self-signed certificates are

unique at the node level.

◦ Ensures that during upgrade, repair, or disaster recovery (DR) in a standalone or high availability

configuration, the self-signed certificate does not get recreated thus avoiding MFA reconfiguration.

◦ Ensures IP-FQDN resolutions.

For information on CA certificate, see Generate CA Certificate CSR file.

Steps

1. Connect to the Active Directory Federation Services (AD FS) host.

2. Download AD FS federation metadata file from "https://<host FQDN>/FederationMetadata/2007-

06/FederationMetadata.xml".

3. Copy the downloaded file to SnapCenter Server to enable MFA feature.

4. Log in to SnapCenter Server as the SnapCenter Administrator user through PowerShell.

5. Using the PowerShell session, generate the SnapCenter MFA metadata file by using the New-

SmMultifactorAuthenticationMetadata -path cmdlet.

The path parameter specifies the path to save the MFA metadata file in the SnapCenter Server host.

6. Copy the generated file to the AD FS host to configure SnapCenter as the client entity.

7. Enable MFA for SnapCenter Server using the Set-SmMultiFactorAuthentication cmdlet.

8. (Optional) Check the MFA configuration status and settings by using Get-

SmMultiFactorAuthentication cmdlet.

9. Go to the Microsoft management console (MMC) and perform the following steps:

a. Click File > Add/Remove Snapin.

8
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b. In the Add or Remove Snap-ins window, select Certificates and then click Add.

c. In the Certificates snap-in window, select the Computer account option, and then click Finish.

d. Click Console Root > Certificates – Local Computer > Personal > Certificates.

e. Right-click on the CA certificate bound to SnapCenter and then select All Tasks > Manage Private

Keys.

f. On the permissions wizard perform the following steps:

i. Click Add.

ii. Click Locations and select the concerned host (top of hierarchy).

iii. Click OK in the Locations pop-up window.

iv. In the object name field, enter ‘IIS_IUSRS’ and click Check Names and click OK.

If the check is successful, click OK.

10. In the AD FS host, open AD FS management wizard and perform the following steps:

a. Right click on Relying Party Trusts > Add Relying Party Trust > Start.

b. Select the second option and browse the SnapCenter MFA Metadata file and click Next.

c. Specify a display name and click Next.

d. Choose an access control policy as required and click Next.

e. Select the settings in the next tab to default.

f. Click Finish.

SnapCenter is now reflected as a relying party with the provided display name.

11. Select the name and perform the following steps:

a. Click Edit Claim Issuance Policy.

b. Click Add Rule and click Next.

c. Specify a name for the claim rule.

d. Select Active Directory as the attribute store.

e. Select the attribute as User-Principal-Name and the outgoing claim type as Name-ID.

f. Click Finish.

12. Run the following PowerShell commands on the ADFS server.

Set-AdfsRelyingPartyTrust -TargetName ‘<Display name of relying party >’

-SigningCertificateRevocationCheck None

Set-AdfsRelyingPartyTrust -TargetName ‘<Display name of relying party >’

-EncryptionCertificateRevocationCheck None

13. Perform the following steps to confirm that the metadata was imported successfully.

a. Right-click the relying party trust and select Properties.

b. Ensure that the Endpoints, Identifiers, and Signature fields are populated.

14. Close all the browser tabs and reopen a browser to clear the existing or active session cookies, and login

again.
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SnapCenter MFA functionality can also be enabled using REST APIs.

For troubleshooting information, see Simultaneous login attempts in multiple tabs shows MFA error.

Update AD FS MFA Metadata

You should update the AD FS MFA metadata in SnapCenter whenever there is any modification in the AD FS

Server, such as upgrade, CA certificate renewal, DR, and so on.

Steps

1. Download AD FS federation metadata file from "https://<host FQDN>/FederationMetadata/2007-

06/FederationMetadata.xml"

2. Copy the downloaded file to SnapCenter Server to update the MFA configuration.

3. Update the AD FS metadata in SnapCenter by running the following cmdlet:

Set-SmMultiFactorAuthentication -Path <location of ADFS MFA metadata xml file>

4. Close all the browser tabs and reopen a browser to clear the existing or active session cookies, and login

again.

Update SnapCenter MFA metadata

You should update the SnapCenter MFA metadata in AD FS whenever there is any modification in ADFS

server such as repair, CA certificate renewal, DR, and so on.

Steps

1. In the AD FS host, open AD FS management wizard and perform the following steps:

a. Select Relying Party Trusts.

b. Right click on the relying party trust that was created for SnapCenter and select Delete.

The user defined name of the relying party trust will be displayed.

c. Enable Multi-factor authentication (MFA).

See Enable Multi-factor authentication.

2. Close all the browser tabs and reopen a browser to clear the existing or active session cookies, and login

again.

Disable Multi-factor authentication (MFA)

Steps

1. Disable MFA and clean up the configuration files that were created when MFA was enabled by using the

Set-SmMultiFactorAuthentication cmdlet.

2. Close all the browser tabs and reopen a browser to clear the existing or active session cookies, and login

again.

Manage multi-factor authentication (MFA) using Rest API, PowerShell, and SCCLI

MFA login is supported from browser, REST API, PowerShell, and SCCLI. MFA is

supported through an AD FS identity manager. You can enable MFA, disable MFA, and
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configure MFA from GUI, REST API, PowerShell, and SCCLI.

Setup AD FS as OAuth/OIDC

Configure AD FS using Windows GUI wizard

1. Navigate to Server Manager Dashboard > Tools > ADFS Management.

2. Navigate to ADFS > Application Groups.

a. Right-click on Application Groups.

b. Select Add Application group and enter Application Name.

c. Select Server Application.

d. Click Next.

3. Copy Client Identifier.

This is the Client ID. .. Add Callback URL (SnapCenter Server URL) in Redirect URL. .. Click Next.

4. Select Generate shared secret.

Copy the secret value. This is the client’s secret. .. Click Next.

5. On the Summary page, click Next.

a. On the Complete page, click Close.

6. Right-click on the newly added Application Group and select Properties.

7. Select Add application from App Properties.

8. Click Add application.

Select Web API and click Next.

9. On the Configure Web API page, enter the SnapCenter Server URL and Client Identifier created in the

previous step into the Identifier section.

a. Click Add.

b. Click Next.

10. On the Choose Access Control Policy page, select control policy based on your requirement (For

example, Permit everyone and require MFA) and click Next.

11. On the Configure Application Permission page, by default openid is selected as a scope, click Next.

12. On the Summary page, click Next.

On the Complete page, click Close.

13. On the Sample Application Properties page, click OK.

14. JWT token issued by an authorization server (AD FS) and intended to be consumed by the resource.

The 'aud' or audience claim of this token must match the identifier of the resource or Web API.

15. Edit the selected WebAPI and check that Callback URL (SnapCenter Server URL) and the client identifier

were added correctly.

Configure OpenID Connect to provide a username as claims.
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16. Open the AD FS Management tool located under the Tools menu at the top right of the Server Manager.

a. Select the Application Groups folder from the left sidebar.

b. Select the Web API and click EDIT.

c. Go-to Issuance Transform Rules Tab

17. Click Add Rule.

a. Select the Send LDAP Attributes as Claims in the Claim rule template dropdown.

b. Click Next.

18. Enter the Claim rule name.

a. Select Active Directory in the Attribute store dropdown.

b. Select User-Principal-Name in the LDAP Attribute dropdown and UPN in the O*utgoing Claim Type*

dropdown.

c. Click Finish.

Create Application Group using PowerShell commands

You can create the application group, web API, and add the scope and claims using PowerShell commands.

These commands are available in automated script format. For more information see <link to KB article>.

1. Create the new Application Group in AD FS by using the following comamnd.

New-AdfsApplicationGroup -Name $ClientRoleIdentifier

-ApplicationGroupIdentifier $ClientRoleIdentifier

ClientRoleIdentifier name of your application group

redirectURL valid URL for redirection after authorization

2. Create the AD FS Server Application and generate the client secret.

Add-AdfsServerApplication -Name "$ClientRoleIdentifier - Server app"

-ApplicationGroupIdentifier $ClientRoleIdentifier -RedirectUri $redirectURL

-Identifier $identifier -GenerateClientSecret

3. Create the ADFS Web API application and configure the policy name it should use.

$identifier = (New-Guid).Guid

Add-AdfsWebApiApplication -ApplicationGroupIdentifier $ClientRoleIdentifier

-Name "App Web API"

-Identifier $identifier -AccessControlPolicyName "Permit everyone"

4. Get the client ID and client secret from the output of the following commands because, it is shown only one

time.

"client_id = $identifier"

"client_secret: "$($ADFSApp.ClientSecret)
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5. Grant the AD FS Application the allatclaims and openid permissions.

Grant-AdfsApplicationPermission -ClientRoleIdentifier $identifier

-ServerRoleIdentifier $identifier -ScopeNames @('openid')

$transformrule = @"

@RuleTemplate = "LdapClaims"

@RuleName = "AD User properties and Groups"

c:[Type ==

"http://schemas.microsoft.com/ws/2008/06/identity/claims/windowsaccountname",

Issuer ==

"AD AUTHORITY"]

⇒ issue(store = "Active Directory", types =

("http://schemas.xmlsoap.org/ws/2005/05/identity/claims/upn"), query =

";userPrincipalName;{0}", param = c.Value);

"@

6. Write out the transform rules file.

$transformrule |Out-File -FilePath .\issueancetransformrules.tmp -force

-Encoding ascii $relativePath = Get-Item .\issueancetransformrules.tmp

7. Name the Web API Application and define its Issuance Transform Rules using an external file.

Set-AdfsWebApiApplication -Name "$ClientRoleIdentifier - Web API"

-TargetIdentifier

$identifier -Identifier $identifier,$redirectURL -IssuanceTransformRulesFile

$relativePath

Update access token expiry time

You can update the access token expiry time using the PowerShell command.

About this task

• An access token can be used only for a specific combination of user, client, and resource. Access tokens

cannot be revoked and are valid until their expiry.

• By default, the expiry time of an access token is 60 minutes. This minimal expiry time is sufficient and

scaled. You must provide sufficient value to avoid any ongoing business-critical jobs.

Step

To update the access token expiry time for an application group WebApi, use the following command in AD FS

server.
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+ Set-AdfsWebApiApplication -TokenLifetime 3600 -TargetName "<Web API>"

Get the bearer token from AD FS

You should fill the below-mentioned parameters in any REST client (like Postman) and it prompts you to fill in

the user credentials. Additionally, you should enter the second-factor authentication (something you have &

something you are) to get the bearer token.

+ The validity of the bearer token is configurable from the AD FS server per application and the default validity

period is 60 minutes.

Field Value

Grant type Authorization Code

Callback URL Enter your application’s base URL if you do not have

a callback URL.

Auth URL [adfs-domain-name]/adfs/oauth2/authorize

Access token URL [adfs-domain-name]/adfs/oauth2/token

Client ID Enter the AD FS client ID

Client secret Enter the AD FS client secret

Scope OpenID

Client Authentication Send as Basic AUTH Header

Resource In the Advance Options tab, add the Resource field

with the same value as the Callback URL, which

comes as an “aud” value in the JWT token.

Configure MFA in SnapCenter Server using PowerShell, SCCLI, and REST API

You can configure MFA in SnapCenter Server using PowerShell, SCCLI, and REST API.

SnapCenter MFA CLI authentication

In PowerShell and SCCLI, the existing cmdlet (Open-SmConnection) is extended with one more field called

"AccessToken" to use the bearer token to authenticate the user.

Open-SmConnection -Credential <PSCredential> [-SMSbaseUrl <String>] [-Port

<String>] [-RoleName <String>] [ -AccessToken <string>]

After the above cmdlet is executed, a session is created for the respective user to execute further SnapCenter

cmdlets.
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SnapCenter MFA Rest API Authentication

Use bearer token in the format Authorization=Bearer <access token> in REST API client (like Postman or

swagger) and mention the user RoleName in the header to get a successful response from SnapCenter.

MFA Rest API Workflow

When MFA is configured with AD FS, you should authenticate using an access (bearer) token to access the

SnapCenter application by any Rest API.

About this task

• You can use any REST client like Postman, Swagger UI or FireCamp.

• Get an access token and use it to authenticate subsequent requests (SnapCenter Rest API) to perform any

operation.

Steps

To authenticate through AD FS MFA

1. Configure the REST client to call AD FS endpoint to get the access token.

When you hit the button to get an access token for an application, you will be redirected to the AD FS SSO

page where you must provide your AD credentials and authenticate with MFA. 1. In the AD FS SSO page,

type your username or email in the Username text box.

+ Usernames must be formatted as user@domain or domain\user.

2. In the Password text box, type your password.

3. Click Log in.

4. From the Sign-in Options section, select an authentication option and authenticate (depending on your

configuration).

◦ Push: Approve the push notification that is sent to your phone.

◦ QR Code: Use the AUTH Point mobile app to scan the QR code, then type the verification code shown

in the app

◦ One-Time Password: Type the one-time password for your token.

5. After successful authentication, a popup will open that contains the Access, ID, and Refresh Token.

Copy the access token and use it in the SnapCenter Rest API to perform the operation.

6. In the Rest API, you should pass the access token and role name in the header section.

7. SnapCenter validates this access token from AD FS.

If it is a valid token, SnapCenter decodes it and gets the username.

8. Using the Username and Role Name, SnapCenter authenticates the user for an API execution.

If the authentication succeeds, SnapCenter returns the result else an error message is displayed.
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Enable or disable SnapCenter MFA functionality for Rest API, CLI, and GUI

GUI

Steps

1. Log into the SnapCenter Server as the SnapCenter Administrator.

2. Click Settings > Global Settings > MultiFactorAuthentication(MFA) Settings

3. Select the interface (GUI/RST API/CLI) to enable or disable the MFA login.

PowerShell interface

Steps

1. Run the PowerShell or CLI commands for enabling MFA for GUI, Rest API, PowerShell, and SCCLI.

Set-SmMultiFactorAuthentication -IsGuiMFAEnabled -IsRestApiMFAEnabled

-IsCliMFAEnabled -Path

The path parameter specifies the location of the AD FS MFA metadata xml file.

Enables MFA for SnapCenter GUI, Rest API, PowerShell, and SCCLI configured with specified AD FS

metadata file path.

2. Check the MFA configuration status and settings by using the Get-SmMultiFactorAuthentication

cmdlet.

SCCLI Interface

Steps

1. # sccli Set-SmMultiFactorAuthentication -IsGuiMFAEnabled true

-IsRESTAPIMFAEnabled true -IsCliMFAEnabled true -Path

"C:\ADFS_metadata\abc.xml"

2. # sccli Get-SmMultiFactorAuthentication

REST APIs

1. Run the following post API for enabling MFA for GUI, Rest API, PowerShell, and SCCLI.

Parameter Value

Requested URL /api/4.9/settings/multifactorauthentication

HTTP method Post

Request Body { "IsGuiMFAEnabled": false,

"IsRestApiMFAEnabled": true, "IsCliMFAEnabled":

false, "ADFSConfigFilePath":

"C:\\ADFS_metadata\\abc.xml" }
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Response Body { "MFAConfiguration": { "IsGuiMFAEnabled": false,

"ADFSConfigFilePath":

"C:\\ADFS_metadata\\abc.xml",

"SCConfigFilePath": null, "IsRestApiMFAEnabled":

true, "IsCliMFAEnabled": false, "ADFSHostName":

"win-adfs-sc49.winscedom2.com" } }

2. Check the MFA configuration status and settings by using the following API.

Parameter Value

Requested URL /api/4.9/settings/multifactorauthentication

HTTP method Get

Response Body { "MFAConfiguration": { "IsGuiMFAEnabled": false,

"ADFSConfigFilePath":

"C:\\ADFS_metadata\\abc.xml",

"SCConfigFilePath": null, "IsRestApiMFAEnabled":

true, "IsCliMFAEnabled": false, "ADFSHostName":

"win-adfs-sc49.winscedom2.com" } }

Install the SnapCenter Server

Install the SnapCenter Server on Windows host

You can run the SnapCenter Server installer executable to install the SnapCenter Server.

You can optionally perform several installation and configuration procedures by using PowerShell cmdlets. You

should be using PowerShell 7.4.2 or later.

Silent installation of the SnapCenter Server from the command-line is not supported.

Before you begin

• The SnapCenter Server host must be up to date with Windows updates with no pending system restarts.

• You should have ensured that MySQL Server is not installed on the host where you plan to install the

SnapCenter Server.

• You should have enabled Windows installer debugging.

See the Microsoft web site for information about enabling Windows installer logging.

You should not install the SnapCenter Server on a host that has Microsoft Exchange Server,

Active Directory, or Domain Name Servers.

Steps

1. Download the SnapCenter Server installation package from NetApp Support Site.
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2. Initiate the SnapCenter Server installation by double-clicking the downloaded .exe file.

After you initiate the installation, all the prechecks are performed and if the minimum requirements are not

met appropriate error or warning messages are displayed.

You can ignore the warning messages and proceed with installation; however, errors should be fixed.

3. Review the pre-populated values required for the SnapCenter Server installation and modify if required.

You do not have to specify the password for MySQL Server repository database. During SnapCenter

Server installation the password is auto generated.

The special character “%” is not supported in the custom path for the repository database. If

you include “%” in the path, installation fails.

4. Click Install Now.

If you have specified any values that are invalid, appropriate error messages will be displayed. You should

reenter the values, and then initiate the installation.

If you click the Cancel button, the step that is being executed will be completed, and then

start the rollback operation. The SnapCenter Server will be completely removed from the

host.

However, if you click Cancel when "SnapCenter Server site restart" or "Waiting for SnapCenter Server to

start" operations are being performed, installation will proceed without cancelling the operation.

Log files are always listed (oldest first) in the %temp% folder of the admin user. If you want to redirect the

log locations, initiate the SnapCenter Server installation from the command prompt by

running:C:\installer_location\installer_name.exe /log"C:\"

Features enabled on Windows host during installation

The SnapCenter Server installer enables the Windows features and roles on your Windows host during

installation. These might be of interest for troubleshooting and maintaining the host system.
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Category Feature

Web Server • Internet Information Services

• World Wide Web Services

• Common HTTP Features

◦ Default Document

◦ Directory Browsing

◦ HTTP Errors

◦ HTTP Redirection

◦ Static Content

◦ WebDAV Publishing

• Health and Diagnostics

◦ Custom Logging

◦ HTTP Logging

◦ Logging Tools

◦ Request Monitor

◦ Tracing

• Performance Features

◦ Static Content Compression

• Security

◦ IP Security

◦ Basic Authentication

◦ Centralized SSL Certificate Support

◦ Client Certificate Mapping Authentication

◦ IIS Client Certificate Mapping Authentication

◦ IP and Domain Restrictions

◦ Request Filtering

◦ URL Authorization

◦ Windows Authentication

• Application Development Features

◦ .NET Extensibility 4.5

◦ Application Initialization

◦ ASP.NET Core Runtime 8.0.12 (and all

subsequent 8.0.x patches) Hosting Bundle

◦ Server-Side Includes

◦ WebSocket Protocol

• Management Tools

◦ IIS Management Console
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Category Feature

IIS Management Scripts and Tools • IIS Management Service

• Web Management Tools

.NET Framework 8.0.12 Features • ASP.NET Core Runtime 8.0.12 (and all

subsequent 8.0.x patches) Hosting Bundle

• Windows Communication Foundation (WCF)

HTTP Activation45

◦ TCP Activation

◦ HTTP Activation

For .NET specific troubleshooting information, see

SnapCenter upgrade or install fails for legacy systems

that do not have internet connectivity.

Windows Process Activation Service Process Model

Configuration APIs All

Install the SnapCenter Server on Linux host

You can run the SnapCenter Server installer executable to install the SnapCenter Server.

Before you begin

• If you want to install the SnapCenter Server using non-root user who does not have enough privileges to

install SnapCenter, get the sudoers checksum file from the NetApp Support site. You should use

appropriate checksum file based on the Linux Version.

• If the sudo package is not available in SUSE Linux, then install the sudo package to avoid authentication

failure.

• For SUSE Linux, configure the hostname to avoid the installation failure.

• Check the secure Linux status by running the command sestatus. If the SELinux status is "enabled" and

the Current mode is "enforcing", perform the following:

◦ Run the command: sudo semanage port -a -t http_port_t -p tcp

<WEBAPP_EXTERNAL_PORT_>

The default value of WEBAPP_EXTERNAL_PORT is 8146

◦ If the firewall blocks the port, run sudo firewall-cmd --add-port

<WEBAPP_EXTERNAL_PORT_>/tcp

The default value of WEBAPP_EXTERNAL_PORT is 8146

◦ Run the following commands from the directory where you have read and write permission:

▪ sudo ausearch -c 'nginx' --raw | audit2allow -M my-nginx

If the command return "nothing to do", rerun the command after installing SnapCenter Server.
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▪ If the command creates my-nginx.pp, run the command to make the policy package active: sudo

semodule -i my-nginx.pp

◦ The path used for MySQL PID directory is /var/opt/mysqld. Run the following commands to set the

permissions for MySQL installation.

▪ mkdir /var/opt/mysqld

▪ sudo semanage fcontext -a -t mysqld_var_run_t "/var/opt/mysqld(/.*)?"

▪ sudo restorecon -Rv /var/opt/mysqld

◦ The path used for MySQL Data directory is

/INSTALL_DIR/NetApp/snapcenter/SnapManagerWeb/Repository/MySQL/. Run the following

commands to set the permissions for MySQL data directory.

▪ mkdir -p /INSTALL_DIR/NetApp/snapcenter/SnapManagerWeb/Repository/MySQL

▪ sudo semanage fcontext -a -t mysqld_db_t

"/INSTALL_DIR/NetApp/snapcenter/SnapManagerWeb/Repository/MySQL(/.*)?"

▪ sudo restorecon -Rv

/INSTALL_DIR/NetApp/snapcenter/SnapManagerWeb/Repository/MySQL

About this task

• When SnapCenter Server is installed on the Linux host, third-party services such as MySQL, RabbitMq,

Errlang gets installed. You should not uninstall them.

• The SnapCenter Server installed on the Linux host does not support:

◦ High availability

◦ Windows plug-ins

◦ Active Directory (Supports only the local users, both root and non-root user with creds)

◦ Key based authentication to log into SnapCenter

• During the installation of .NET runtime, if the installation fails to resolve the dependencies of libicu library,

then install libicu by running the command: yum install -y libicu

• If the installation of SnapCenter Server fails due to the non-availability of Perl, then install Perl by running

the command: yum install -y perl

Steps

1. Download the following from NetApp Support Site to /home directory.

◦ SnapCenter Server installation package - snapcenter-linux-server-(el8/el9/sles15).bin

◦ Public key file - snapcenter_public_key.pub

◦ Respective signature file - snapcenter-linux-server-(el8/el9/sles15).bin.sig

2. Validate the signature file. $openssl dgst -sha256 -verify snapcenter_public_key.pub

-signature <path to signature file> <path to bin file>

3. For non-root user installation, add the visudo content specified in

snapcenter_server_checksum_(el8/el9/sles15).txt available along with the .bin installer.

4. Assign the execute permission for the .bin installer. chmod +x snapcenter-linux-server-

(el8/el9/sles15).bin

5. Perform one of the actions to install SnapCenter Server.
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If you want to perform… Do this…

Interactive installation ./snapcenter-linux-server-

(el8/el9/sles15).bin

You will be prompted to enter the following details:

• The webapp external port that is used to access

SnapCenter Server outside the Linux host. The

default value is 8146.

• The SnapCenter Server user who will install

SnapCenter Server.

• The installation directory where packages will

be installed.
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If you want to perform… Do this…

Non interactive installation sudo ./snapcenter-linux-server-

(el8/el9/sles15).bin -i silent

-DWEBAPP_EXTERNAL_PORT=<port>

-DWEBAPP_INTERNAL_PORT=<port>

-DSMCORE_PORT=<port>

-DSCHEDULER_PORT=<port>

-DSNAPCENTER_SERVER_USER=<user>

-DUSER_INSTALL_DIR=<dir>

-DINSTALL_LOG_NAME=<filename>

Example: sudo ./snapcenter_linux_server.bin -i

silent -DWEBAPP_EXTERNAL_PORT=8146

-DSNAPCENTER_SERVER_USER=root

-DUSER_INSTALL_DIR=/opt

-DINSTALL_LOG_NAME=InstallerLog.log

Logs will be stored at /var/opt/snapcenter/logs.

Parameters to be passed for installing SnapCenter

Server:

• DWEBAPP_EXTERNAL_PORT: Webapp

external port that is used to access SnapCenter

Server outside the Linux host. The default value

is 8146.

• DWEBAPP_INTERNAL_PORT: Webapp

internal port that is used to access SnapCenter

Server within the Linux host. The default value

is 8147.

• DSMCORE_PORT: SMCore port on which the

smcore services are running. The default value

is 8145.

• DSCHEDULER_PORT: Scheduler port on which

the scheduler services are running. The default

value is 8154.

• DSNAPCENTER_SERVER_USER:

SnapCenter Server user who will install

SnapCenter Server. For

DSNAPCENTER_SERVER_USER, the default

is the user running the installer.

• DUSER_INSTALL_DIR: Installation directory

where packages will be installed. For

DUSER_INSTALL_DIR, the default installation

directory is /opt.

• DINSTALL_LOG_NAME: Log file name where

installation logs will be stored. This is an

optional parameter and if specified no logs will

be displayed on the console.If you do not

specify this parameter, logs will be displayed on

the console and also stored in the default log

file.

DSELINUX: If the SELinux status is "enabled",

the Current mode is "enforcing", and you have
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•

executed the commands mentioned in Before

you begin section, you should specify this

parameter and assign the value as 1. The

default value is 0.

• DUPGRADE: The default value is 0. Specify this

parameter and it’s value as any integer other

than 0 to upgrade the SnapCenter Server.

What’s next?

• If the SELinux status is "enabled" and the Current mode is "enforcing", the nginx service fails to start. You

should run the the following commands:

1. Go to home directory.

2. Run the command: journalctl -x|grep nginx.

3. If the Webapp internal port (8147) is not allowed to listen, run the following commands:

▪ ausearch -c 'nginx' --raw | audit2allow -M my-nginx

▪ semodule -i my-nginx.pp

4. Run setsebool -P httpd_can_network_connect on

Features enabled on Linux host during installation

The SnapCenter Server installs below software packages which can help in troubleshooting and maintaining

the host system.

• Rabbitmq

• Erlang

Register SnapCenter

If you are new to NetApp products and do not have an existing NetApp account, you

should register SnapCenter to enable support.

Steps

1. After installing SnapCenter, navigate to Help > About.

2. In the About SnapCenter dialog box, make a note of the SnapCenter Instance, a 20 digit number that starts

with 971.

3. Click https://register.netapp.com.

4. Click I am not a registered NetApp Customer.

5. Specify your details to register yourself.

6. Leave the NetApp Reference SN field blank.

7. Select SnapCenter from the Product Line drop-down.

8. Select the billing provider.

9. Enter the 20-digit SnapCenter instance ID.

10. Click Submit.

Log in to SnapCenter using RBAC authorization

SnapCenter supports role-based access control (RBAC). SnapCenter admin assigns

roles and resources through SnapCenter RBAC to either a user in workgroup or active

directory, or to groups in active directory. The RBAC user can now log in to SnapCenter

with the assigned roles.

Before you begin
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• You should enable Windows Process Activation Service (WAS) in Windows Server Manager.

• If you want to use Internet Explorer as the browser to log in to the SnapCenter Server, you should ensure

that the Protected Mode in Internet Explorer is disabled.

• If SnapCenter Server is installed on Linux host, you should log in using the user account which was used to

install the SnapCenter Server.

About this task

During installation, the SnapCenter Server Install wizard creates a shortcut and places it on the desktop and in

the Start menu of the host where SnapCenter is installed. Additionally, at the end of the installation, the Install

wizard displays the SnapCenter URL based on the information that you provided during installation, which you

can copy if you want to log in from a remote system.

If you have multiple tabs open in your web browser, closing just the SnapCenter browser tab

does not log you out of SnapCenter. To end your connection with SnapCenter, you must log out

of SnapCenter either by clicking the Sign out button, or by closing the entire web browser.

Best Practice: For security reasons, it is recommended that you do not enable your browser to save your

SnapCenter password.

The default GUI URL is a secure connection to the default port 8146 on the server where the SnapCenter

Server is installed (https://server:8146). If you provided a different server port during the SnapCenter

installation, that port is used instead.

For High Availability (HA) deployment, you must access SnapCenter using the virtual cluster IP

https://Virtual_Cluster_IP_or_FQDN:8146. If you do not see the SnapCenter UI when you navigate to

https://Virtual_Cluster_IP_or_FQDN:8146 in Internet Explorer (IE), you must add the Virtual Cluster IP address

or FQDN as a trusted site in IE on each plug-in host, or you must disable IE Enhanced Security on each plug-

in host. For more information, see Unable to access cluster IP address from outside network.

In addition to using the SnapCenter GUI, you can use PowerShell cmdlets to create scripts to perform

configuration, backup, and restore operations. Some cmdlets might have changed with each SnapCenter

release. The SnapCenter Software Cmdlet Reference Guide has the details.

If you are logging in to SnapCenter for the first time, you must log in using the credentials that

you provided during the install process.

Steps

1. Launch SnapCenter from the shortcut located on your local host desktop, or from the URL provided at the

end of the installation, or from the URL provided by your SnapCenter administrator.

2. Enter user credentials.

To specify the following… Use one of these formats…

Domain administrator • NetBIOS\UserName

• UserName@UPN suffix

For example, username@netapp.com

• Domain FQDN\UserName
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To specify the following… Use one of these formats…

Local administrator UserName

3. If you are assigned more than one role, from the Role box, select the role that you want to use for this login

session.

Your current user and associated role are shown in the upper right of SnapCenter after you are logged in.

Result

The Dashboard page is displayed.

If the logging fails with the error that site cannot be reached, you should map the SSL certificate to

SnapCenter. Learn more

After you finish

After logging to SnapCenter Server as an RBAC user for the first time, refresh the resources list.

If you have untrusted Active Directory domains that you want SnapCenter to support, you must register those

domains with SnapCenter before configuring the roles for the users on untrusted domains. Learn more.

If you want to add the plug-in host in SnapCenter running on Linux host, you should get the checksum file from

the location: /opt/NetApp/snapcenter/SnapManagerWeb/Repository.

From 6.0 release, a shortcut for SnapCenter PowerShell is created on the desktop. You can directly access the

SnapCenter PowerShell cmdlets by using the shortcut.

Log in to SnapCenter using Multi-Factor Authentication (MFA)

SnapCenter Server supports MFA for domain account, which is part of the active directory.

Before you begin

You should have enabled MFA. For information on how to enable MFA, see Enable Multi-factor authentication

About this task

• Only FQDN is supported

• Workgroup and cross domain users cannot login using MFA

Steps

1. Launch SnapCenter from the shortcut located on your local host desktop, or from the URL provided at the

end of the installation, or from the URL provided by your SnapCenter administrator.

2. In the AD FS login page, enter Username and Password.

When the username or password invalid error message is displayed on the AD FS page, you should check

for the following:

◦ Whether the username or password is valid

The user account should exist in the Active Directory (AD)
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◦ Whether you exceeded the maximum allowed attempts that was set in AD

◦ Whether AD and AD FS is up and running

Modify the SnapCenter default GUI session timeout

You can modify the SnapCenter GUI session timeout period to make it less than or greater than the default

timeout period of 20 minutes.

As a security feature, after a default period of 15 minutes of inactivity, SnapCenter warns you that you will be

logged out of the GUI session in 5 minutes. By default, SnapCenter logs you out of the GUI session after 20

minutes of inactivity, and you must log in again.

Steps

1. In the left navigation pane, click Settings > Global Settings.

2. In the Global Settings page, click Configuration Settings.

3. In the Session Timeout field, enter the new session timeout in minutes, and then click Save.

Secure the SnapCenter web server by disabling SSL 3.0

For security purposes, you should disable Secure Socket Layer (SSL) 3.0 protocol in Microsoft IIS if it is

enabled on your SnapCenter web server.

There are flaws in the SSL 3.0 protocol that an attacker can use to cause connection failures, or to perform

man-in-the-middle attacks and observe the encryption traffic between your website and its visitors.

Steps

1. To launch Registry Editor on the SnapCenter web server host, click Start > Run, and then enter regedit.

2. In Registry Editor, navigate to

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\S

SL 3.0\.

◦ If the Server key already exists:

i. Select the Enabled DWORD, and then click Edit > Modify.

ii. Change the value to 0, and then click OK.

◦ If the Server key does not exist:

i. Click Edit > New > Key, and then name the key Server.

ii. With the new Server key selected, click Edit > New > DWORD.

iii. Name the new DWORD Enabled, and then enter 0 as the value.

3. Close Registry Editor.

Configure the SnapCenter Server

Add and provision the storage system

Add storage systems

You should set up the storage system that gives SnapCenter access to ONTAP storage,
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ASA r2 systems, or Amazon FSx for NetApp ONTAP to perform data protection and

provisioning operations.

You can either add a stand-alone SVM or a cluster comprising of multiple SVMs. If you are using Amazon FSx

for NetApp ONTAP, you can either add FSx admin LIF comprising of multiple SVMs using fsxadmin account or

add FSx SVM in SnapCenter.

Before you begin

• You should have the required permissions in the Infrastructure Admin role to create storage connections.

• You should ensure that the plug-in installations are not in progress.

Host plug-in installations must not be in progress while adding a storage system connection because the

host cache might not be updated and databases status might be displayed in the SnapCenter GUI as “Not

available for backup” or “Not on NetApp storage”.

• Storage system names should be unique.

SnapCenter does not support multiple storage systems with the same name on different clusters. Each

storage system that is supported by SnapCenter should have a unique name and a unique data LIF IP

address.

About this task

• When you configure storage systems, you can also enable Event Management System (EMS) &

AutoSupport features. The AutoSupport tool collects data about the health of your system and

automatically sends the data to NetApp technical support, enabling them to troubleshoot your system.

If you enable these features, SnapCenter sends AutoSupport information to the storage system and EMS

messages to the storage system syslog when a resource is protected, a restore or clone operation finishes

successfully, or an operation fails.

• If you are planning to replicate Snapshots to a SnapMirror destination or SnapVault destination, you must

set up storage system connections for the destination SVM or Cluster as well as the source SVM or

Cluster.

If you change the storage system password, scheduled jobs, on demand backup, and restore

operations might fail. After you change the storage system password, you can update the

password by clicking Modify in the Storage tab.

Steps

1. In the left navigation pane, click Storage Systems.

2. In the Storage Systems page, click New.

3. In the Add Storage System page, provide the following information:
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For this field… Do this…

Storage System Enter the storage system name or IP address.

Storage system names, not including

the domain name, must have 15 or

fewer characters, and the names

must be resolvable. To create

storage system connections with

names that have more than 15

characters, you can use the Add-

SmStorageConnectionPowerShell

cmdlet.

For storage systems with

MetroCluster configuration (MCC), it

is recommended to register both

local and peer clusters for non-

disruptive operations.

SnapCenter does not support multiple SVMs with

the same name on different clusters. Each SVM that

is supported by SnapCenter must have a unique

name.

After adding the storage connection

to SnapCenter, you should not

rename the SVM or the Cluster using

ONTAP.

If SVM is added with a short name or

FQDN then it has to be resolvable

from both the SnapCenter and the

plug-in host.

User name/Password Enter the credentials of the storage user that has

the required privileges to access the storage

system.
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For this field… Do this…

Event Management System (EMS) & AutoSupport

Settings

If you want to send EMS messages to the storage

system syslog or if you want to have AutoSupport

messages sent to the storage system for applied

protection, completed restore operations, or failed

operations, select the appropriate checkbox.

When you select the Send AutoSupport

Notification for failed operations to storage

system checkbox, the Log SnapCenter Server

events to syslog checkbox is also selected

because EMS messaging is required to enable

AutoSupport notifications.

4. Click More Options if you want to modify the default values assigned to platform, protocol, port, and

timeout.

a. In Platform, select one of the options from the drop-down list.

If the SVM is the secondary storage system in a backup relationship, select the Secondary checkbox.

When the Secondary option is selected, SnapCenter does not perform a license check immediately.

If you have added SVM in SnapCenter then, user need to select the platform type from the dropdown

manually.

b. In Protocol, select the protocol that was configured during SVM or Cluster setup, typically HTTPS.

c. Enter the port that the storage system accepts.

The default port 443 typically works.

d. Enter the time in seconds that should elapse before communication attempts are halted.

The default value is 60 seconds.

e. If the SVM has multiple management interfaces, select the Preferred IP checkbox, and then enter the

preferred IP address for SVM connections.

f. Click Save.

5. Click Submit.

Result

In the Storage Systems page, from the Type drop-down perform one of the following actions:

• Select ONTAP SVMs if you want to view all the SVMs that were added.

If you have added FSx SVMs, the FSx SVMs are listed here.

• Select ONTAP Clusters if you want to view all the clusters that were added.

If you have added FSx clusters using fsxadmin, the FSx clusters are listed here.

When you click on the cluster name, all the SVMs that are part of the cluster are displayed in the Storage

Virtual Machines section.
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If a new SVM is added to the ONTAP cluster using ONTAP GUI, click Rediscover to view the newly added

SVM.

After you finish

A cluster administrator must enable AutoSupport on each storage system node to send email notifications from

all storage systems to which SnapCenter has access, by running the following command from the storage

system command line:

autosupport trigger modify -node nodename -autosupport-message client.app.info

-to enable -noteto enable

The Storage Virtual Machine (SVM) administrator has no access to AutoSupport.

Storage connections and credentials

Before performing data protection operations, you should set up the storage connections

and add the credentials that the SnapCenter Server and the SnapCenter plug-ins will

use.

Storage connections

The storage connections give the SnapCenter Server and SnapCenter plug-ins access to the ONTAP storage.

Setting up these connections also involves configuring AutoSupport and Event Management System (EMS)

features.

Credentials

• Domain administrator or any member of the administrator group

Specify the domain administrator or any member of the administrator group on the system on which you

are installing the SnapCenter plug-in. Valid formats for the Username field are:

◦ NetBIOS\UserName

◦ Domain FQDN\UserName

◦ UserName@upn

• Local administrator (for workgroups only)

For systems that belong to a workgroup, specify the built-in local administrator on the system on which you

are installing the SnapCenter plug-in. You can specify a local user account that belongs to the local

administrators group if the user account has elevated privileges or the User Access control feature is

disabled on the host system.

The valid format for the Username field is: UserName

• Credentials for individual resource groups

If you set up credentials for individual resource groups and the username does not have full admin

privileges, you must assign at least the resource group and backup privileges to the username.
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Provision storage on Windows hosts

Create and manage igroups

You create initiator groups (igroups) to specify which hosts can access a given LUN on

the storage system. You can use SnapCenter to create, rename, modify, or delete an

igroup on a Windows host.

Create an igroup

You can use SnapCenter to create an igroup on a Windows host. The igroup will be available in the Create

Disk or Connect Disk wizard when you map the igroup to a LUN.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Igroup.

3. In the Initiator Groups page, click New.

4. In the Create Igroup dialog box, define the igroup:

In this field… Do this…

Storage System Select the SVM for the LUN you will map to the

igroup.

Host Select the host on which you want to create the

igroup.

Igroup Name Enter the name of the igroup.

Initiators Select the initiator.

Type Select the initiator type, iSCSI, FCP, or mixed (FCP

and iSCSI).

5. When you are satisfied with your entries, click OK.

SnapCenter creates the igroup on the storage system.

Rename an igroup

You can use SnapCenter to rename an existing igroup.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Igroup.

3. In the Initiator Groups page, click in the Storage Virtual Machine field to display a list of available SVMs,

and then select the SVM for the igroup you want to rename.
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4. In the list of igroups for the SVM, select the igroup you want to rename and click Rename.

5. In the Rename igroup dialog box, enter the new name for the igroup and click Rename.

Modify an igroup

You can use SnapCenter to add igroup initiators to an existing igroup. While creating an igroup you can add

only one host. If you want to create an igroup for a cluster, you can modify the igroup to add other nodes to that

igroup.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Igroup.

3. In the Initiator Groups page, click in the Storage Virtual Machine field to display a drop-down list of

available SVMs, then select the SVM for the igroup you want to modify.

4. In the list of igroups, select an igroup and click Add Initiator to igroup.

5. Select a host.

6. Select the initiators and click OK.

Delete an igroup

You can use SnapCenter to delete an igroup when you no longer need it.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Igroup.

3. In the Initiator Groups page, click in the Storage Virtual Machine field to display a drop-down list of

available SVMs, then select the SVM for the igroup you want to delete.

4. In the list of igroups for the SVM, select the igroup you want to delete and click Delete.

5. In the Delete igroup dialog box, click OK.

SnapCenter deletes the igroup.

Create and manage disks

The Windows host sees LUNs on your storage system as virtual disks. You can use

SnapCenter to create and configure an FC-connected or iSCSI-connected LUN.

• SnapCenter supports only basic disks. The dynamic disks are not supported.

• For GPT only one data partition and for MBR one primary partition is allowed that has one volume

formatted with NTFS or CSVFS and has one mount path.

• Supported partition styles: GPT, MBR; in a VMware UEFI VM, only iSCSI disks are supported

SnapCenter does not support renaming a disk. If a disk that is managed by SnapCenter is

renamed, SnapCenter operations will not succeed.
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View the disks on a host

You can view the disks on each Windows host you manage with SnapCenter.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Disks.

3. Select the host from the Host drop-down list.

The disks are listed.

View clustered disks

You can view clustered disks on the cluster that you manage with SnapCenter. The clustered disks are

displayed only when you select the cluster from the Hosts drop-down.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Disks.

3. Select the cluster from the Host drop-down list.

The disks are listed.

Establish an iSCSI session

If you are using iSCSI to connect to a LUN, you must establish an iSCSI session before you create the LUN to

enable communication.

Before you begin

• You must have defined the storage system node as an iSCSI target.

• You must have started the iSCSI service on the storage system. Learn more

About this task

You can establish an iSCSI session only between the same IP versions, either from IPv6 to IPv6, or from IPv4

to IPv4.

You can use a link-local IPv6 address for iSCSI session management and for communication between a host

and a target only when both are in the same subnet.

If you change the name of an iSCSI initiator, access to iSCSI targets is affected. After changing the name, you

might require to reconfigure the targets accessed by the initiator so that they can recognize the new name. You

must ensure to restart the host after changing the name of an iSCSI initiator.

If your host has more than one iSCSI interface, once you have established an iSCSI session to SnapCenter

using an IP address on the first interface, you cannot establish an iSCSI session from another interface with a

different IP address.

Steps
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1. In the left navigation pane, click Hosts.

2. In the Hosts page, click iSCSI Session.

3. From the Storage Virtual Machine drop-down list, select the storage virtual machine (SVM) for the iSCSI

target.

4. From the Host drop-down list, select the host for the session.

5. Click Establish Session.

The Establish Session wizard is displayed.

6. In the Establish Session wizard, identify the target:

In this field… Enter…

Target node name The node name of the iSCSI target

If there is an existing target node name, the name is

displayed in read-only format.

Target portal address The IP address of the target network portal

Target portal port The TCP port of the target network portal

Initiator portal address The IP address of the initiator network portal

7. When you are satisfied with your entries, click Connect.

SnapCenter establishes the iSCSI session.

8. Repeat this procedure to establish a session for each target.

Create FC-connected or iSCSI-connected LUNs or disks

The Windows host sees the LUNs on your storage system as virtual disks. You can use SnapCenter to create

and configure an FC-connected or iSCSI-connected LUN.

If you want to create and format disks outside of SnapCenter, only NTFS and CSVFS file systems are

supported.

Before you begin

• You must have created a volume for the LUN on your storage system.

The volume should hold LUNs only, and only LUNs created with SnapCenter.

You cannot create a LUN on a SnapCenter-created clone volume unless the clone has

already been split.

• You must have started the FC or iSCSI service on the storage system.

• If you are using iSCSI, you must have established an iSCSI session with the storage system.

• The SnapCenter Plug-ins Package for Windows must be installed only on the host on which you are
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creating the disk.

About this task

• You cannot connect a LUN to more than one host unless the LUN is shared by hosts in a Windows Server

failover cluster.

• If a LUN is shared by hosts in a Windows Server failover cluster that uses CSV (Cluster Shared Volumes),

you must create the disk on the host that owns the cluster group.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Disks.

3. Select the host from the Host drop-down list.

4. Click New.

The Create Disk wizard opens.

5. In the LUN Name page, identify the LUN:

In this field… Do this…

Storage System Select the SVM for the LUN.

LUN path Click Browse to select the full path of the folder

containing the LUN.

LUN name Enter the name of the LUN.

Cluster size Select the LUN block allocation size for the cluster.

Cluster size depends upon the operating system

and applications.

LUN label Optionally, enter descriptive text for the LUN.

6. In the Disk Type page, select the disk type:

Select… If…

Dedicated disk The LUN can be accessed by only one host.

Ignore the Resource Group field.

Shared disk The LUN is shared by hosts in a Windows Server

failover cluster.

Enter the name of the cluster resource group in the

Resource Group field. You need to create the disk

on only one host in the failover cluster.
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Select… If…

Cluster Shared Volume (CSV) The LUN is shared by hosts in a Windows Server

failover cluster that uses CSV.

Enter the name of the cluster resource group in the

Resource Group field. Make sure that the host on

which you are creating the disk is the owner of the

cluster group.

7. In the Drive Properties page, specify the drive properties:

Property Description

Auto assign mount point SnapCenter automatically assigns a volume mount

point based on the system drive.

For example, if your system drive is C:, auto assign

creates a volume mount point under your C: drive

(C:\scmnpt\). Auto assign is not supported for

shared disks.

Assign drive letter Mount the disk to the drive you select in the

adjacent drop-down list.

Use volume mount point Mount the disk to the drive path you specify in the

adjacent field.

The root of the volume mount point must be owned

by the host on which you are creating the disk.

Do not assign drive letter or volume mount point Choose this option if you prefer to mount the disk

manually in Windows.

LUN size Specify the LUN size; 150 MB minimum.

Select MB, GB, or TB in the adjoining drop-down

list.

Use thin provisioning for the volume hosting this

LUN

Thin provision the LUN.

Thin provisioning allocates only as much storage

space as is needed at one time, allowing the LUN to

grow efficiently to the maximum available capacity.

Make sure there is enough space available on the

volume to accommodate all the LUN storage you

think you will need.
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Property Description

Choose partition type Select GPT partition for a GUID Partition Table, or

MBR partition for a Master Boot Record.

MBR partitions might cause misalignment issues in

Windows Server failover clusters.

Unified extensible firmware interface

(UEFI) partition disks are not

supported.

8. In the Map LUN page, select the iSCSI or FC initiator on the host:

In this field… Do this…

Host Double-click the cluster group name to display a

drop-down list that shows the hosts that belong to

the cluster, and then select the host for the initiator.

This field is displayed only if the LUN is shared by

hosts in a Windows Server failover cluster.

Choose host initiator Select Fibre Channel or iSCSI, and then select the

initiator on the host.

You can select multiple FC initiators if you are using

FC with multipath I/O (MPIO).

9. In the Group Type page, specify whether you want to map an existing igroup to the LUN, or create a new

igroup:

Select… If…

Create new igroup for selected initiators You want to create a new igroup for the selected

initiators.

Choose an existing igroup or specify a new igroup

for selected initiators

You want to specify an existing igroup for the

selected initiators, or create a new igroup with the

name you specify.

Type the igroup name in the igroup name field.

Type the first few letters of the existing igroup name

to autocomplete the field.

10. In the Summary page, review your selections and then click Finish.

SnapCenter creates the LUN and connects it to the specified drive or drive path on the host.
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Resize a disk

You can increase or decrease the size of a disk as your storage system needs change.

About this task

• For thin provisioned LUN, the ONTAP lun geometry size is shown as the maximum size.

• For thick provisioned LUN, the expandable size (available size in the volume) is shown as the maximum

size.

• LUNs with MBR-style partitions have a size limit of 2 TB.

• LUNs with GPT-style partitions have a storage system size limit of 16 TB.

• It is a good idea to make a Snapshot before resizing a LUN.

• If you need to restore a LUN from a Snapshot made before the LUN was resized, SnapCenter

automatically resizes the LUN to the size of the Snapshot.

After the restore operation, data added to the LUN after it was resized must be restored from a Snapshot

made after it was resized.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Disks.

3. Select the host from the Host drop-down list.

The disks are listed.

4. Select the disk you want to resize and then click Resize.

5. In the Resize Disk dialog box, use the slider tool to specify the new size of the disk, or enter the new size in

the Size field.

If you enter the size manually, you need to click outside the Size field before the Shrink or

Expand button is enabled appropriately. Also, you must click MB, GB, or TB to specify the

unit of measurement.

6. When you are satisfied with your entries, click Shrink or Expand, as appropriate.

SnapCenter resizes the disk.

Connect a disk

You can use the Connect Disk wizard to connect an existing LUN to a host, or to reconnect a LUN that has

been disconnected.

Before you begin

• You must have started the FC or iSCSI service on the storage system.

• If you are using iSCSI, you must have established an iSCSI session with the storage system.

• You cannot connect a LUN to more than one host unless the LUN is shared by hosts in a Windows Server

failover cluster.
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• If the LUN is shared by hosts in a Windows Server failover cluster that uses CSV (Cluster Shared

Volumes), then you must connect the disk on the host that owns the cluster group.

• The Plug-in for Windows needs to be installed only on the host on which you are connecting the disk.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Disks.

3. Select the host from the Host drop-down list.

4. Click Connect.

The Connect Disk wizard opens.

5. In the LUN Name page, identify the LUN to connect to:

In this field… Do this…

Storage System Select the SVM for the LUN.

LUN path Click Browse to select the full path of the volume

containing the LUN.

LUN name Enter the name of the LUN.

Cluster size Select the LUN block allocation size for the cluster.

Cluster size depends upon the operating system

and applications.

LUN label Optionally, enter descriptive text for the LUN.

6. In the Disk Type page, select the disk type:

Select… If…

Dedicated disk The LUN can be accessed by only one host.

Shared disk The LUN is shared by hosts in a Windows Server

failover cluster.

You need only connect the disk to one host in the

failover cluster.

Cluster Shared Volume (CSV) The LUN is shared by hosts in a Windows Server

failover cluster that uses CSV.

Make sure that the host on which you are

connecting to the disk is the owner of the cluster

group.
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7. In the Drive Properties page, specify the drive properties:

Property Description

Auto assign Let SnapCenter automatically assign a volume

mount point based on the system drive.

For example, if your system drive is C:, the auto

assign property creates a volume mount point under

your C: drive (C:\scmnpt\). The auto assign property

is not supported for shared disks.

Assign drive letter Mount the disk to the drive you select in the

adjoining drop-down list.

Use volume mount point Mount the disk to the drive path you specify in the

adjoining field.

The root of the volume mount point must be owned

by the host on which you are creating the disk.

Do not assign drive letter or volume mount point Choose this option if you prefer to mount the disk

manually in Windows.

8. In the Map LUN page, select the iSCSI or FC initiator on the host:

In this field… Do this…

Host Double-click the cluster group name to display a

drop-down list that shows the hosts that belong to

the cluster, then select the host for the initiator.

This field is displayed only if the LUN is shared by

hosts in a Windows Server failover cluster.

Choose host initiator Select Fibre Channel or iSCSI, and then select the

initiator on the host.

You can select multiple FC initiators if you are using

FC with MPIO.

9. In the Group Type page, specify whether you want to map an existing igroup to the LUN or create a new

igroup:

Select… If…

Create new igroup for selected initiators You want to create a new igroup for the selected

initiators.
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Select… If…

Choose an existing igroup or specify a new igroup

for selected initiators

You want to specify an existing igroup for the

selected initiators, or create a new igroup with the

name you specify.

Type the igroup name in the igroup name field.

Type the first few letters of the existing igroup name

to automatically complete the field.

10. In the Summary page, review your selections and click Finish.

SnapCenter connects the LUN to the specified drive or drive path on the host.

Disconnect a disk

You can disconnect a LUN from a host without affecting the contents of the LUN, with one exception: If you

disconnect a clone before it has been split off, you lose the contents of the clone.

Before you begin

• Make sure that the LUN is not in use by any application.

• Make sure that the LUN is not being monitored with monitoring software.

• If the LUN is shared, make sure to remove the cluster resource dependencies from the LUN and verify that

all nodes in the cluster are powered on, functioning properly, and available to SnapCenter.

About this task

If you disconnect a LUN in a FlexClone volume that SnapCenter has created and no other LUNs on the volume

are connected, SnapCenter deletes the volume. Before disconnecting the LUN, SnapCenter displays a

message warning you that the FlexClone volume might be deleted.

To avoid automatic deletion of the FlexClone volume, you should rename the volume before disconnecting the

last LUN. When you rename the volume, make sure that you change multiple characters than just the last

character in the name.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Disks.

3. Select the host from the Host drop-down list.

The disks are listed.

4. Select the disk you want to disconnect, and then click Disconnect.

5. In the Disconnect Disk dialog box, click OK.

SnapCenter disconnects the disk.
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Delete a disk

You can delete a disk when you no longer need it. After you delete a disk, you cannot undelete it.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Disks.

3. Select the host from the Host drop-down list.

The disks are listed.

4. Select the disk you want to delete, and then click Delete.

5. In the Delete Disk dialog box, click OK.

SnapCenter deletes the disk.

Create and manage SMB shares

To configure an SMB3 share on a storage virtual machine (SVM), you can use either the

SnapCenter user interface or PowerShell cmdlets.

Best Practice: Using the cmdlets is recommended because it enables you to take advantage of templates

provided with SnapCenter to automate share configuration.

The templates encapsulate best practices for volume and share configuration. You can find the templates in

the Templates folder in the installation folder for the SnapCenter Plug-ins Package for Windows.

If you feel comfortable doing so, you can create your own templates following the models

provided. You should review the parameters in the cmdlet documentation before creating a

custom template.

Create an SMB share

You can use the SnapCenter Shares page to create an SMB3 share on a storage virtual machine (SVM).

You cannot use SnapCenter to back up databases on SMB shares. SMB support is limited to provisioning only.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Shares.

3. Select the SVM from the Storage Virtual Machine drop-down list.

4. Click New.

The New Share dialog opens.

5. In the New Share dialog, define the share:
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In this field… Do this…

Description Enter descriptive text for the share.

Share name Enter the share name, for example, test_share.

The name you enter for the share will also be used

as the volume name.

The share name:

• Must be a UTF-8 string.

• Must not include the following characters:

control characters from 0x00 to 0x1F (both

inclusive), 0x22 (double quotes), and the special

characters \ / [ ] : (vertical bar) <

> + = ; , ?

Share path • Click in the field to enter a new file system path,

for example, /.

• Double-click in the field to select from a list of

existing file system paths.

6. When you are satisfied with your entries, click OK.

SnapCenter creates the SMB share on the SVM.

Delete an SMB share

You can delete an SMB share when you no longer need it.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Shares.

3. In the Shares page, click in the Storage Virtual Machine field to display a drop-down with a list of

available storage virtual machines (SVMs), then select the SVM for the share you want to delete.

4. From the list of shares on the SVM, select the share you want to delete and click Delete.

5. In the Delete Share dialog box, click OK.

SnapCenter deletes the SMB share from the SVM.

Reclaim space on the storage system

Although NTFS tracks the available space on a LUN when files are deleted or modified, it

does not report the new information to the storage system. You can run the space

reclamation PowerShell cmdlet on the Plug-in for Windows host to ensure that newly

freed blocks are marked as available in storage.
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If you are running the cmdlet on a remote plug-in host, you must have run the SnapCenterOpen-

SMConnection cmdlet to open a connection to the SnapCenter Server.

Before you begin

• You must ensure that the space reclamation process has completed before performing a restore operation.

• If the LUN is shared by hosts in a Windows Server failover cluster, you must perform space reclamation on

the host that owns the cluster group.

• For optimum storage performance, you should perform space reclamation as often as possible.

You should ensure that the entire NTFS file system has been scanned.

About this task

• Space reclamation is time-consuming and CPU-intensive, so it is usually best to run the operation when

storage system and Windows host usage is low.

• Space reclamation reclaims nearly all available space, but not 100 percent.

• You should not run disk defragmentation at the same time as you are performing space reclamation.

Doing so can slow the reclamation process.

Step

From the application server PowerShell command prompt, enter the following command:

Invoke-SdHostVolumeSpaceReclaim -Path drive_path

drive_path is the drive path mapped to the LUN.

Provision storage using PowerShell cmdlets

If you do not want to use the SnapCenter GUI to perform host provisioning and space

reclamation jobs, you can use the PowerShell cmdlets. You can use cmdlets directly or

add them to scripts.

If you are running the cmdlets on a remote plug-in host, you must run the SnapCenter Open-SMConnection

cmdlet to open a connection to the SnapCenter Server.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software

Cmdlet Reference Guide.

If SnapCenter PowerShell cmdlets are broken due to removal of SnapDrive for Windows from the server, refer

to SnapCenter cmdlets broken when SnapDrive for Windows is uninstalled.

Provision storage in VMware environments

You can use the SnapCenter Plug-in for Microsoft Windows in VMware environments to

create and manage LUNs and manage Snapshots.
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Supported VMware guest OS platforms

• Supported versions of Windows Server

• Microsoft cluster configurations

Support for up to a maximum of 16 nodes supported on VMware when using the Microsoft iSCSI Software

Initiator, or up to two nodes using FC

• RDM LUNs

Support for a maximum of 56 RDM LUNs with four LSI Logic SCSI controllers for normal RDMS, or 42

RDM LUNs with three LSI Logic SCSI controllers on a VMware VM MSCS box-to-box Plug-in for Windows

configuration

Supports VMware ParaVirtual SCSI Controller. 256 disks can be supported on RDM disks.

VMware ESXi server-related limitations

• Installing the Plug-in for Windows on a Microsoft cluster on virtual machines using ESXi credentials is not

supported.

You should use your vCenter credentials when installing the Plug-in for Windows on clustered virtual

machines.

• All clustered nodes must use the same target ID (on the virtual SCSI adapter) for the same clustered disk.

• When you create an RDM LUN outside of the Plug-in for Windows, you must restart the plug-in service to

enable it to recognize the newly created disk.

• You cannot use iSCSI and FC initiators at the same time on a VMware guest OS.

Minimum vCenter privileges required for SnapCenter RDM operations

You should have the following vCenter privileges on the host to perform RDM operations in a guest OS:

• Datastore: Remove File

• Host: Configuration > Storage Partition Configuration

• Virtual Machine: Configuration

You must assign these privileges to a role at the Virtual Center Server level. The role to which you assign these

privileges cannot be assigned to any user without root privileges.

After you assign these privileges, you can install the Plug-in for Windows on the guest OS.

Manage FC RDM LUNs in a Microsoft cluster

You can use the Plug-in for Windows to manage a Microsoft cluster using FC RDM LUNs, but you must first

create the shared RDM quorum and shared storage outside the plug-in, and then add the disks to the virtual

machines in the cluster.

Starting with ESXi 5.5, you can also use ESX iSCSI and FCoE hardware to manage a Microsoft cluster. The

Plug-in for Windows includes out-of-box support for Microsoft clusters.
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Requirements

The Plug-in for Windows provides support for Microsoft clusters using FC RDM LUNs on two different virtual

machines that belong to two different ESX or ESXi servers, also known as cluster across boxes, when you

meet specific configuration requirements.

• The virtual machines (VMs) must be running the same Windows Server version.

• ESX or ESXi server versions must be the same for each VMware parent host.

• Each parent host must have at least two network adapters.

• There must be at least one VMware Virtual Machine File System (VMFS) datastore shared between the

two ESX or ESXi servers.

• VMware recommends that the shared datastore be created on an FC SAN.

If necessary, the shared datastore can also be created over iSCSI.

• The shared RDM LUN must be in physical compatibility mode.

• The shared RDM LUN must be created manually outside of the Plug-in for Windows.

You cannot use virtual disks for shared storage.

• A SCSI controller must be configured on each virtual machine in the cluster in physical compatibility mode:

Windows Server 2008 R2 requires you to configure the LSI Logic SAS SCSI controller on each virtual

machine. Shared LUNs cannot use the existing LSI Logic SAS controller if only one of its type exists and it

is already attached to the C: drive.

SCSI controllers of type paravirtual are not supported on VMware Microsoft clusters.

When you add a SCSI controller to a shared LUN on a virtual machine in physical

compatibility mode, you must select the Raw Device Mappings (RDM) option and not the

Create a new disk option in the VMware Infrastructure Client.

• Microsoft virtual machine clusters cannot be part of a VMware cluster.

• You must use vCenter credentials and not ESX or ESXi credentials when you install the Plug-in for

Windows on virtual machines that belongs to a Microsoft cluster.

• The Plug-in for Windows cannot create a single igroup with initiators from multiple hosts.

The igroup containing the initiators from all ESXi hosts must be created on the storage controller prior to

creating the RDM LUNs that will be used as shared cluster disks.

• Ensure that you create an RDM LUN on ESXi 5.0 using an FC initiator.

When you create an RDM LUN, an initiator group is created with ALUA.

Limitations

The Plug-in for Windows supports Microsoft clusters using FC/iSCSI RDM LUNs on different virtual machines

belonging to different ESX or ESXi servers.

This feature is not supported in releases before ESX 5.5i.
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• The Plug-in for Windows does not support clusters on ESX iSCSI and NFS datastores.

• The Plug-in for Windows does not support mixed initiators in a cluster environment.

Initiators must be either FC or Microsoft iSCSI, but not both.

• ESX iSCSI initiators and HBAs are not supported on shared disks in a Microsoft cluster.

• The Plug-in for Windows does not support virtual machine migration with vMotion if the virtual machine is

part of a Microsoft cluster.

• The Plug-in for Windows does not support MPIO on virtual machines in a Microsoft cluster.

Create a shared FC RDM LUN

Before you can use FC RDM LUNs to share storage between nodes in a Microsoft cluster, you must first create

the shared quorum disk and shared storage disk, and then add them to both virtual machines in the cluster.

The shared disk is not created using the Plug-in for Windows. You should create and then add the shared LUN

to each virtual machine in the cluster.

Related information

Refer to Broadcom Technical Documentation and search for documentation on clustering virtual machines

across physical hosts and creating shared FC RDM LUNs for Microsoft clusters.

Add SnapCenter Standard controller-based licenses

A SnapCenter Standard controller-based license is required if you are using FAS, AFF, or

ASA storage controllers.

The controller-based license has the following characteristics:

• SnapCenter Standard entitlement included with purchase of Premium or Flash Bundle (not with the base

pack)

• Unlimited storage usage

• Added directly to the FAS, AFF, or ASA storage controller by using either ONTAP System Manager or the

ONTAP CLI.

You do not enter any license information in the SnapCenter user interface for the

SnapCenter controller-based licenses.

• Locked to the controller’s serial number

For information on the licenses required, see SnapCenter licenses.

Step 1: Verify if the SnapManager Suite license is installed

You can use the SnapCenter user interface to check if a SnapManager Suite license is installed on FAS, AFF,

or ASA primary storage systems and identify which systems that need licenses. SnapManager Suite licenses

apply only to FAS, AFF, and ASA SVMs or clusters on primary storage systems.
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If you already have a SnapManager Suite license on your controller, SnapCenter automatically

provides the Standard controller-based license entitlement. The names SnapManagerSuite

license and SnapCenter Standard controller-based license are used interchangeably, but they

refer to the same license.

Steps

1. In the left navigation pane, select Storage Systems.

2. In the Storage Systems page, from the Type drop-down, select whether to view all the SVMs or clusters

that were added:

◦ To view all of the SVMs that were added, select ONTAP SVMs.

◦ To view all of the clusters that were added, select ONTAP Clusters.

When you select the cluster name, all of the SVMs that are part of the cluster are displayed in the

Storage Virtual Machines section.

3. In the Storage Connections list, locate the Controller License column.

The Controller License column displays the following status:

◦

 indicates that a SnapManager Suite license is installed on a FAS, AFF, or ASA primary storage

system.

◦

 indicates that a SnapManager Suite license is not installed on a FAS, AFF, or ASA primary

storage system.

◦ Not applicable indicates that a SnapManager Suite license is not applicable because the storage

controller is on Amazon FSx for NetApp ONTAP, Cloud Volumes ONTAP, ONTAP Select, or Secondary

storage platforms.

Step 2: Identify the licenses installed on the controller

You can use the ONTAP command line to view all the licenses installed on your controller. You should be a

cluster administrator on the FAS, AFF, or ASA system.

The controller displays the SnapCenter Standard controller-based license as the

SnapManagerSuite license.

Steps

1. Log in to the NetApp controller using the ONTAP command line.

2. Enter the license show command, and then view the output to see if the SnapManagerSuite license is

installed.
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Example output

cluster1::> license show

(system license show)

Serial Number: 1-80-0000xx

Owner: cluster1

Package           Type     Description              Expiration

----------------- -------- ---------------------    ---------------

Base              site     Cluster Base License     -

Serial Number: 1-81-000000000000000000000000xx

Owner: cluster1-01

Package           Type     Description              Expiration

----------------- -------- ---------------------    ---------------

NFS               license  NFS License              -

CIFS              license  CIFS License             -

iSCSI             license  iSCSI License            -

FCP               license  FCP License              -

SnapRestore       license  SnapRestore License      -

SnapMirror        license  SnapMirror License       -

FlexClone         license  FlexClone License        -

SnapVault         license  SnapVault License        -

SnapManagerSuite  license  SnapManagerSuite License -

In the example, the SnapManagerSuite license is installed, therefore, no additional SnapCenter licensing

action is required.

Step 3: Retrieve the controller serial number

Get the controller serial number using the ONTAP command line. You must be a cluster administrator on the

FAS, AFF, or ASA system to get your controller-based license serial number.

Steps

1. Log in to the controller using the ONTAP command line.

2. Enter the system show -instance command, and then review the output to locate the controller serial

number.

50



Example output

cluster1::> system show -instance

Node: fasxxxx-xx-xx-xx

Owner:

Location: RTP 1.5

Model: FAS8080

Serial Number: 123451234511

Asset Tag: -

Uptime: 143 days 23:46

NVRAM System ID: xxxxxxxxx

System ID: xxxxxxxxxx

Vendor: NetApp

Health: true

Eligibility: true

Differentiated Services: false

All-Flash Optimized: false

Node: fas8080-41-42-02

Owner:

Location: RTP 1.5

Model: FAS8080

Serial Number: 123451234512

Asset Tag: -

Uptime: 144 days 00:08

NVRAM System ID: xxxxxxxxx

System ID: xxxxxxxxxx

Vendor: NetApp

Health: true

Eligibility: true

Differentiated Services: false

All-Flash Optimized: false

2 entries were displayed.

3. Record the serial numbers.

Step 4: Retrieve the serial number of the controller-based license

If you are using FAS, ASA, or AFF storage, you can retrieve the SnapCenter controller-based license from the

NetApp Support Site before you install it using the ONTAP command line.

Before you begin

• You should have a valid NetApp Support Site login credentials.

If you do not enter valid credentials, the system does not return any information for your search.

51



• You should have the controller serial number.

Steps

1. Log in to the NetApp Support Site.

2. Navigate to Systems > Software Licenses.

3. In the Selection Criteria area, ensure Serial Number (located on back of unit) is selected, enter the

controller serial number, and then select Go!.

A list of licenses for the specified controller is displayed.

4. Locate and record the SnapCenter Standard or SnapManagerSuite license.

Step 5: Add controller-based license

You can use the ONTAP command line to add a SnapCenter controller-based license when you are using FAS,

AFF, or ASA systems, and you have a SnapCenter Standard or SnapManagerSuite license.

Before you begin

• You should be a cluster administrator on the FAS, AFF, or ASA system.

• You should have the SnapCenter Standard or SnapManagerSuite license.

About this task

If you want to install SnapCenter on a trial basis with FAS, AFF, or ASA storage, you can obtain a Premium

Bundle evaluation license to install on your controller.

If you want to install SnapCenter on a trial basis, you should contact your sales representative to obtain a

Premium Bundle evaluation license to install on your controller.

Steps

1. Log in to the NetApp cluster using the ONTAP command line.

2. Add the SnapManagerSuite license key:

system license add -license-code license_key

This command is available at the admin privilege level.

3. Verify that the SnapManagerSuite license is installed:

license show

52

http://mysupport.netapp.com/


Step 6: Remove the trial license

If you are using a controller-based SnapCenter Standard license and need to remove the capacity-based trial

license (serial number ending with “50”), you should use MySQL commands to remove the trial license

manually. The trial license cannot be deleted using the SnapCenter user interface.

Removing a trial license manually is only required if you are using a SnapCenter Standard

controller-based license.

Steps

1. On the SnapCenter Server, open a PowerShell window to reset the MySQL password.

a. Run the Open-SmConnection cmdlet to establish connection with the SnapCenter Server for a

SnapCenterAdmin account.

b. Run the Set-SmRepositoryPassword to reset the MySQL password.

For information about the cmdlets, see SnapCenter Software Cmdlet Reference Guide.

2. Open the command prompt and run mysql -u root -p to log into MySQL.

MySQL prompts you for the password. Enter the credentials you provided while resetting the password.

3. Remove the trial license from the database:

use nsm;DELETE FROM nsm_License WHERE nsm_License_Serial_Number='510000050';

Configure High Availability

Configure SnapCenter Servers for High Availability

To support High Availability (HA) in SnapCenter running either on Windows or on Linux,

you can install the F5 load balancer. F5 enables the SnapCenter Server to support active-

passive configurations in up to two hosts that are in the same location. To use F5 Load

Balancer in SnapCenter, you should configure the SnapCenter Servers and configure F5

load balancer.

You can also configure Network Load Balancing (NLB) to set up SnapCenter High Availability. You should

manually configure NLB outside of SnapCenter installation for high availability.

For cloud environment, you can configure high availability using either Amazon Web Services (AWS) Elastic

Load Balancing (ELB) and Azure load balancer.
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Configure high availability using F5

For instruction to configure SnapCenter Servers for high availability using F5 load balancer, refer to How

to configure SnapCenter Servers for high availability using F5 Load Balancer.

You must be a member of the Local Administrators group on the SnapCenter Servers (in addition to being

assigned to the SnapCenterAdmin role) to use the following cmdlets for adding and removing F5 clusters:

• Add-SmServerCluster

• Add-SmServer

• Remove-SmServerCluster

For more information, refer to SnapCenter Software Cmdlet Reference Guide.

Additional information

• After you install and configure SnapCenter for high availability, edit the SnapCenter desktop shortcut

to point to the F5 cluster IP.

• If a failover occurs between SnapCenter Servers and if there is also an existing SnapCenter session,

you must close the browser and log on to SnapCenter again.

• In load balancer setup (NLB or F5), if you add a host that is partially resolved by the NLB or F5 host

and if the SnapCenter host is not able to reach out to this host, then the SnapCenter host page

switches between hosts down and running state frequently. To resolve this issue, you should ensure

that both the SnapCenter hosts are able to resolve the host in NLB or F5 host.

• SnapCenter commands for MFA settings should be executed on all the hosts. Relying party

configuration should be done in the Active Directory Federation Services (AD FS) server using F5

cluster details. The host level SnapCenter UI access will be blocked after MFA is enabled.

• During failover, the audit log settings will not reflect on the second host. Hence, you should manually

repeat the audit log settings on F5 passive host when it becomes active.

Configure high availability using Network Load Balancing (NLB)

You can configure Network Load Balancing (NLB) to set up SnapCenter High Availability. You should

manually configure NLB outside of SnapCenter installation for high availability.

For information about how to configure Network Load Balancing (NLB) with SnapCenter refer to How to

configure NLB with SnapCenter.

Configure high availability using AWS Elastic Load Balancing (ELB)

You can configure high availability SnapCenter environment in Amazon Web Services (AWS) by setting

up two SnapCenter servers in separate availability zones (AZs) and configuring them for automatic

failover. The architecture includes virtual private IP addresses, routing tables, and synchronization

between active and standby MySQL databases.

Steps

1. Configure virtual private overlay IP in AWS. For information, refer to Configure virtual private overlay

IP.

2. Prepare your Windows host

a. Force IPv4 being prioritized above IPv6:

▪ Location: HKLM\SYSTEM\CurrentControlSet\Services\Tcpip6\Parameters
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▪ Key: DisabledComponents

▪ Type: REG_DWORD

▪ Value: 0x20

b. Ensure that the fully qualified domain names can be resolved via DNS or via local host

configuration to the IPv4 addresses.

c. Ensure that you do not have a system proxy configured.

d. Ensure that the administrator password is same on both the Windows Server when using a setup

without an Active Directory and the servers are not in one domain.

e. Add virtual IP on both Windows Servers.

3. Create the SnapCenter cluster.

a. Start Powershell and connect to SnapCenter. Open-SmConnection

b. Create the cluster. Add-SmServerCluster -ClusterName <cluster_name> -ClusterIP

<cluster_ip> -PrimarySCServerIP <primary_ip> -Verbose -Credential

administrator

c. Add the secondary server. Add-SmServer -ServerName <server_name> -ServerIP

<server_ip> -CleanUpSecondaryServer -Verbose -Credential administrator

d. Get the high availability details. Get-SmServerConfig

4. Create the Lamda function to adjust the routing table in case the virtual private IP endpoint becomes

unavailable, monitored by AWS CloudWatch. For information, refer to Create a Lambda function.

5. Create a monitor in CloudWatch to monitor the availability of the SnapCenter endpoint. An alarm is

configured to trigger a Lambda function if the endpoint is unreachable. The Lambda function adjusts

the routing table to redirect traffic to the active SnapCenter server. For information, refer to Create

synthetic canaries.

6. Implement workflow using a step function as an alternative to CloudWatch monitoring, providing

smaller failover times. The workflow includes a Lambda probe function to test the SnapCenter URL, a

DynamoDB table for storing failure counts, and the Step Function itself.

a. Use a lambda function for probing the SnapCenter URL. For information, refer to Create Lambda

function.

b. Create a DynamoDB table for storing the failure count between two Step Function iterations. For

information, refer to Get started with DynamoDB table.

c. Create the Step Function. For information, refer to Step Function documentation.

d. Test a single step.

e. Test the complete function.

f. Create IAM Role and adjust permissions to be allowed to execute Lambda function.

g. Create schedule to trigger Step Function. For information, refer to Using Amazon EventBridge

Scheduler to start a Step Functions.

Configure high availability using Azure load balancer

You can configure high availability SnapCenter environment using Azure load balancer.

Steps

1. Create virtual machines in a scale set using Azure portal. The Azure virtual machine scale set allows

you to create and manage a group of load balanced virtual machines. The number of virtual machine
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instances can automatically increase or decrease in response to demand or a defined schedule. For

information, refer to Create virtual machines in a scale set using Azure portal.

2. After configuring the virtual machines, log into each virtual machine in VM set and install SnapCenter

Server in both the nodes.

3. Create the cluster in host 1. Add-SmServerCluster -ClusterName <cluster_name>

-ClusterIP <specify the load balancer front end virtual ip>

-PrimarySCServerIP <ip address> -Verbose -Credential <credentials>

4. Add the secondary server. Add-SmServer -ServerName <name of node2> -ServerIP <ip

address of node2> -Verbose -Credential <credentials>

5. Obtain the high availability details. Get-SmServerConfig

6. If required, rebuild the secondary host. Set-SmRepositoryConfig -RebuildSlave -Verbose

7. Failover to the second host. Set-SmRepositoryConfig ActiveMaster <name of node2>

-Verbose

== Switch from NLB to F5 for high availability

You can change your SnapCenter HA configuration from Network Load Balancing (NLB) to use F5 Load

Balancer.

Steps

1. Configure SnapCenter Servers for high availability using F5. Learn more.

2. On the SnapCenter Server host, launch PowerShell.

3. Start a session by using the Open-SmConnection cmdlet, and then enter your credentials.

4. Update the SnapCenter Server to point to the F5 cluster IP address using the Update-

SmServerCluster cmdlet.

The information regarding the parameters that can be used with the cmdlet and their descriptions can

be obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter

Software Cmdlet Reference Guide.

High availability for the SnapCenter MySQL repository

MySQL replication is a feature of MySQL Server that enables you to replicate data from

one MySQL database server (master) to another MySQL database server (slave).

SnapCenter supports MySQL replication for high availability only on two Network Load

Balancing-enabled (NLB-enabled) nodes.

SnapCenter performs read or write operations on the master repository and routes its connection to the slave

repository when there is a failure on the master repository. The slave repository then becomes the master

repository. SnapCenter also supports reverse replication, which is enabled only during failover.

If you want to use the MySQL high availability (HA) feature, you must configure Network Load Balancer (NLB)

on the first node. The MySQL repository is installed on this node as part of the installation. While installing

SnapCenter on the second node, you must join to the F5 of the first node and create a copy of the MySQL

repository on the second node.

SnapCenter provides the Get-SmRepositoryConfig and Set-SmRepositoryConfig PowerShell cmdlets to
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manage MySQL replication.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software

Cmdlet Reference Guide.

You must be aware of the limitations related to the MySQL HA feature:

• NLB and MySQL HA are not supported beyond two nodes.

• Switching from a SnapCenter standalone installation to an NLB installation or vice versa and switching

from a MySQL standalone setup to MySQL HA are not supported.

• Automatic failover is not supported if the slave repository data is not synchronized with the master

repository data.

You can initiate a forced failover by using the Set-SmRepositoryConfig cmdlet.

• When failover is initiated, jobs that are running might fail.

If failover happens because MySQL Server or SnapCenter Server is down, then any jobs that are running

might fail. After failing over to the second node, all subsequent jobs run successfully.

For information about configuring high availability, see How to configure NLB and ARR with SnapCenter.

Configure role-based access control (RBAC)

Create a role

In addition to using the existing SnapCenter roles, you can create your own roles and

customize the permissions.

To create your own roles, it is necessary to log in as the "SnapCenterAdmin" role.

Steps

1. In the left navigation pane, click Settings.

2. In the Settings page, click Roles.

3. Click .

4. Specify a name and description for the new role.

Only the following special characters can be used in user names and group names: space (

), hyphen (-), underscore (_), and colon (:).

5. Select All members of this role can see other members' objects to enable other members of the role to

see resources such as volumes and hosts after they refresh the resources list.

You should deselect this option if you do not want members of this role to see objects to which other

members are assigned.

When this option is enabled, assigning users access to objects or resources is not required

if users belong to the same role as the user who created the objects or resources.
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6. In the Permissions page, select the permissions that you want to assign to the role, or click Select All to

grant all permissions to the role.

7. Click Submit.

Add an NetApp ONTAP RBAC role using security login commands

You can use the security login commands to add a NetApp ONTAP RBAC role when your

storage systems are running clustered ONTAP.

Before you begin

• Identify the task (or tasks) that you want to perform and the privileges required to perform these tasks.

• Grant privileges to commands and/or command directories.

There are two levels of access for each command/command directory: all-access and read-only.

You must always assign the all-access privileges first.

• Assign roles to users.

• Identify your configuration depending on whether your SnapCenter plug-ins are connected to the Cluster

Administrator IP for the entire cluster or directly connected to a SVM within the cluster.

About this task

To simplify the configuration of these roles on storage systems, you can use the RBAC User Creator for

NetApp ONTAP tool, which is posted on the NetApp Communities Forum.

This tool automatically handles setting up the ONTAP privileges correctly. For example, RBAC User Creator for

NetApp ONTAP tool automatically adds the privileges in the correct order so that the all-access privileges

appear first. If you add the read-only privileges first and then add the all-access privileges, ONTAP marks the

all-access privileges as duplicates and ignores them.

If you later upgrade SnapCenter or ONTAP, you should re-run the RBAC User Creator for

NetApp ONTAP tool to update the user roles you created previously. User roles created for an

earlier version of SnapCenter or ONTAP do not work properly with upgraded versions. When

you re-run the tool, it automatically handles the upgrade. You do not need to recreate the roles.

More information about setting up ONTAP RBAC roles, see the ONTAP 9 Administrator Authentication and

RBAC Power Guide.

Steps

1. On the storage system, create a new role by entering the following command:

security login role create <role_name\> -cmddirname "command" -access all

–vserver <svm_name\>

◦ svm_name is the name of the SVM. If you leave this blank, it defaults to cluster administrator.

◦ role_name is the name you specify for the role.

◦ command is the ONTAP capability.

You must repeat this command for each permission. Remember that all-access

commands must be listed before read-only commands.
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For information about the list of permissions, see ONTAP CLI commands for creating roles and

assigning permissions.

2. Create a user name by entering the following command:

security login create -username <user_name\> -application ontapi -authmethod

<password\> -role <name_of_role_in_step_1\> –vserver <svm_name\> -comment

"user_description"

◦ user_name is the name of the user you are creating.

◦ <password> is your password. If you do not specify a password, the system will prompt you for one.

◦ svm_name is the name of the SVM.

3. Assign the role to the user by entering the following command:

security login modify username <user_name\> –vserver <svm_name\> -role

<role_name\> -application ontapi -application console -authmethod <password\>

◦ <user_name> is the name of the user you created in Step 2. This command lets you modify the user to

associate it with the role.

◦ <svm_name> is the name of the SVM.

◦ <role_name> is the name of the role you created in Step 1.

◦ <password> is your password. If you do not specify a password, the system will prompt you for one.

4. Verify that the user was created correctly by entering the following command:

security login show –vserver <svm_name\> -user-or-group-name <user_name\>

user_name is the name of the user you created in Step 3.

Create SVM roles with minimum privileges

There are several ONTAP CLI commands you must run when you create a role for a new

SVM user in ONTAP. This role is required if you configure SVMs in ONTAP to use with

SnapCenter and you do not want to use the vsadmin role.

Steps

1. On the storage system, create a role and assign all the permissions to the role.

security login role create –vserver <svm_name\>- role <SVM_Role_Name\>

-cmddirname <permission\>

You should repeat this command for each permission.

2. Create a user and assign the role to that user.

security login create -user <user_name\> -vserver <svm_name\> -application

ontapi -authmethod password -role <SVM_Role_Name\>

3. Unlock the user.
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security login unlock -user <user_name\> -vserver <svm_name\>

ONTAP CLI commands for creating SVM roles and assigning permissions

There are several ONTAP CLI commands you should run to create SVM roles and assign permissions.

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"snapmirror list-destinations" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"event generate-autosupport-log" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"job history show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"job show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"job stop" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"lun" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun igroup add" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun igroup create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun igroup delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun igroup rename" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun igroup show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun mapping add-reporting-nodes" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"lun mapping create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun mapping delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun mapping remove-reporting-nodes" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun mapping show" -access all
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• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun modify" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun move-in-volume" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun offline" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun online" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun resize" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun serial" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"network interface" -access readonly

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror policy add-rule" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror policy modify-rule" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror policy remove-rule" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror policy show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror restore" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"snapmirror show-history" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror update" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror update-ls-set" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"version" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume clone create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume clone show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname
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"volume clone split start" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume clone split stop" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume destroy" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume file clone create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume file show-disk-usage" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume modify" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume offline" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume online" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume qtree create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume qtree delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume qtree modify" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume qtree show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume restrict" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot modify" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"volume snapshot modify-snaplock-expiry-time" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot rename" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot restore" -access all
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• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot restore-file" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot show-delta" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume unmount" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver cifs share create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver cifs share delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver cifs share show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver cifs show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy rule create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy rule show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"vserver iscsi connection show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver" -access readonly

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver iscsi" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"volume clone split status" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume managed-feature" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem map" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

63



"nvme subsystem create" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem delete" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem modify" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem host" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem controller" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme namespace create" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme namespace delete" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme namespace modify" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme namespace show" -access all

Create SVM roles for ASA r2 systems

There are several ONTAP CLI commands you must run to create a role for a new SVM

user in ASA r2 systems. This role is required if you configure SVMs in ASA r2 systems to

use with SnapCenter and you do not want to use the vsadmin role.

Steps

1. On the storage system, create a role and assign all the permissions to the role.

security login role create –vserver <svm_name\>- role <SVM_Role_Name\>

-cmddirname <permission\>

You should repeat this command for each permission.

2. Create a user and assign the role to that user.

security login create -user <user_name\> -vserver <svm_name\> -application

http -authmethod password -role <SVM_Role_Name\>

3. Unlock the user.

security login unlock -user <user_name\> -vserver <svm_name\>
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ONTAP CLI commands for creating SVM roles and assigning permissions

There are several ONTAP CLI commands you should run to create SVM roles and assign permissions.

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"snapmirror list-destinations" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"event generate-autosupport-log" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"job history show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"job show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"job stop" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"lun" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun igroup add" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun igroup create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun igroup delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun igroup rename" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun igroup show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun mapping add-reporting-nodes" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"lun mapping create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun mapping delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun mapping remove-reporting-nodes" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun mapping show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun modify" -access all
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• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun move-in-volume" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun offline" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun online" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun resize" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun serial" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"lun show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"network interface" -access readonly

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror policy add-rule" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror policy modify-rule" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror policy remove-rule" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror policy show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror restore" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"snapmirror show-history" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror update" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"snapmirror update-ls-set" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"version" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume clone create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume clone show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume clone split start" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname
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"volume clone split stop" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume destroy" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume file clone create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume file show-disk-usage" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume modify" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume offline" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume online" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume qtree create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume qtree delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume qtree modify" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume qtree show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume restrict" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot modify" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"volume snapshot modify-snaplock-expiry-time" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot rename" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot restore" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot restore-file" -access all
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• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume snapshot show-delta" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume unmount" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver cifs share create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver cifs share delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver cifs share show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver cifs show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy delete" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy rule create" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy rule show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"vserver iscsi connection show" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver" -access readonly

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver export-policy" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"vserver iscsi" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"volume clone split status" -access all

• security login role create -vserver SVM_name -role SVM_Role_Name -cmddirname

"volume managed-feature" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem map" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem create" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname
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"nvme subsystem delete" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem modify" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem host" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem controller" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme subsystem show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme namespace create" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme namespace delete" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme namespace modify" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"nvme namespace show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"storage-unit show" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"consistency-group" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"snapmirror protect" -access all

• security login role create -vserver SVM_Name -role SVM_Role_Name -cmddirname

"volume delete" -access all

• security login create -user-or-group-name user_name -application http

-authentication-method password -role SVM_Role_Name -vserver SVM_Name

• security login create -user-or-group-name user_name -application ssh

-authentication-method password -role SVM_Role_Name -vserver SVM_Name

Create ONTAP cluster roles with minimum privileges

You should create an ONTAP cluster role with minimum privileges so that you do not

have to use the ONTAP admin role to perform operations in SnapCenter. You can run

several ONTAP CLI commands to create the ONTAP cluster role and assign minimum

privileges.

Steps

1. On the storage system, create a role and assign all the permissions to the role.

security login role create –vserver <cluster_name\>- role <role_name\>

-cmddirname <permission\>
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You should repeat this command for each permission.

2. Create a user and assign the role to that user.

security login create -user <user_name\> -vserver <cluster_name\> -application

ontapi http -authmethod password -role <role_name\>

3. Unlock the user.

security login unlock -user <user_name\> -vserver <cluster_name\>

ONTAP CLI commands for creating cluster roles and assigning permissions

There are several ONTAP CLI commands you should run to create cluster roles and assign permissions.

• security login role create -vserver Cluster_name or cluster_name -role

Role_Name -cmddirname "metrocluster show" -access readonly

• security login role create -vserver Cluster_name or cluster_name -role

Role_Name -cmddirname "cluster identity modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"cluster identity show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"cluster modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"cluster peer show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"cluster show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"event generate-autosupport-log" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"job history show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"job show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"job stop" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun igroup add" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname
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"lun igroup create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun igroup delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun igroup modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun igroup rename" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun igroup show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun mapping add-reporting-nodes" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun mapping create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun mapping delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun mapping remove-reporting-nodes" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun mapping show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun move-in-volume" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun offline" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun online" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun persistent-reservation clear" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun resize" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun serial" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"network interface create" -access readonly

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"network interface delete" -access readonly

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"network interface modify" -access readonly
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• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"network interface show" -access readonly

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem map" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem host" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem controller" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme namespace create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme namespace delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme namespace modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme namespace show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"security login" -access readonly

• security login role create -role Role_Name -cmddirname "snapmirror create"

-vserver Cluster_name -access all

• security login role create -role Role_Name -cmddirname "snapmirror list-

destinations" -vserver Cluster_name -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy add-rule" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy modify-rule" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname
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"snapmirror policy remove-rule" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror restore" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror show-history" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror update" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror update-ls-set" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system license add" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system license clean-up" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system license delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system license show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system license status show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system node modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system node show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system status show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"version" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume clone create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume clone show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume clone split start" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume clone split stop" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume create" -access all
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• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume destroy" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume file clone create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume file show-disk-usage" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot modify-snaplock-expiry-time" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume offline" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume online" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume qtree create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume qtree delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume qtree modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume qtree show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume restrict" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot promote" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot rename" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot restore" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot restore-file" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname
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"volume snapshot show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot show-delta" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume unmount" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs share modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs share create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs share delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs share modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs share show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy rule create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy rule delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy rule modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy rule show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy show" -access all
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• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver iscsi connection show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver show" -access all

Create ONTAP cluster roles for ASA r2 systems

You should create an ONTAP cluster role with minimum privileges so that you do not

have to use the ONTAP admin role to perform operations in SnapCenter. You can run

several ONTAP CLI commands to create the ONTAP cluster role and assign minimum

privileges.

Steps

1. On the storage system, create a role and assign all the permissions to the role.

security login role create –vserver <cluster_name\>- role <role_name\>

-cmddirname <permission\>

You should repeat this command for each permission.

2. Create a user and assign the role to that user.

security login create -user <user_name\> -vserver <cluster_name\> -application

http -authmethod password -role <role_name\>

3. Unlock the user.

security login unlock -user <user_name\> -vserver <cluster_name\>

ONTAP CLI commands for creating cluster roles and assigning permissions

There are several ONTAP CLI commands you should run to create cluster roles and assign permissions.

• security login role create -vserver Cluster_name or cluster_name -role

Role_Name -cmddirname "metrocluster show" -access readonly

• security login role create -vserver Cluster_name or cluster_name -role

Role_Name -cmddirname "cluster identity modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"cluster identity show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"cluster modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"cluster peer show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"cluster show" -access all
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• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"event generate-autosupport-log" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"job history show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"job show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"job stop" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun igroup add" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun igroup create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun igroup delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun igroup modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun igroup rename" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun igroup show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun mapping add-reporting-nodes" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun mapping create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun mapping delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun mapping remove-reporting-nodes" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun mapping show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun move-in-volume" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname
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"lun offline" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun online" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun persistent-reservation clear" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun resize" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun serial" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"lun show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"network interface create" -access readonly

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"network interface delete" -access readonly

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"network interface modify" -access readonly

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"network interface show" -access readonly

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem map" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem host" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem controller" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme subsystem show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme namespace create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme namespace delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme namespace modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"nvme namespace show" -access all
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• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"security login" -access readonly

• security login role create -role Role_Name -cmddirname "snapmirror create"

-vserver Cluster_name -access all

• security login role create -role Role_Name -cmddirname "snapmirror list-

destinations" -vserver Cluster_name -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy add-rule" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy modify-rule" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy remove-rule" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror policy show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror restore" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror show-history" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror update" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror update-ls-set" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system license add" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system license clean-up" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system license delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system license show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system license status show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname
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"system node modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system node show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"system status show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"version" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume clone create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume clone show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume clone split start" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume clone split stop" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume destroy" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume file clone create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume file show-disk-usage" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot modify-snaplock-expiry-time" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume offline" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume online" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume qtree create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume qtree delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume qtree modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume qtree show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume restrict" -access all
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• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot promote" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot rename" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot restore" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot restore-file" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume snapshot show-delta" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume unmount" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs share modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs share create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs share delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs share modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver cifs share show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname
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"vserver cifs show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy rule create" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy rule delete" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy rule modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy rule show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver export-policy show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver iscsi connection show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver modify" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"vserver show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"storage-unit show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"consistency-group" show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"snapmirror protect" show" -access all

• security login role create -vserver Cluster_name -role Role_Name -cmddirname

"volume delete" show" -access all

Add a user or group and assign role and assets

To configure role-based access control for SnapCenter users, you can add users or

groups and assign role. The role determines the options that SnapCenter users can

access.

Before you begin

• You must have logged in as the "SnapCenterAdmin" role.

• You must have created the user or group accounts in Active Directory in the operating system or database.

You cannot use SnapCenter to create these accounts.
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You can include only the following special characters in user names and group names:

space ( ), hyphen (-), underscore (_), and colon (:).

• SnapCenter includes several predefined roles.

You can either assign these roles to the user or create new roles.

• AD Users and AD Groups that are added to SnapCenter RBAC must have the READ permission on the

Users Container and the Computers Container in the Active Directory.

• After you assign a role to a user or group that contains the appropriate permissions, you must assign the

user access to SnapCenter assets, such as hosts and storage connections.

This enables users to perform the actions for which they have permissions on the assets that are assigned

to them.

• You should assign a role to the user or group at some point to take advantage of RBAC permissions and

efficiencies.

• You can assign assets like host, resource groups, policy, storage connection, plug-in, and credential to the

user while creating the user or group.

• The minimum assets that you should assign an user to perform certain operations are as follows:

Operation Assets assignment

Protect resources host, policy

Backup host, resource group, policy

Restore host, resource group

Clone host, resource group, policy

Clone lifecycle host

Create a Resource Group host

• When a new node is added to a Windows cluster or a DAG (Exchange Server Database Availability Group)

asset and if this new node is assigned to a user, you must reassign the asset to the user or group to

include the new node to the user or group.

You should reassign the RBAC user or group to the cluster or DAG to include the new node to the RBAC

user or group. For example, you have a two-node cluster and you have assigned an RBAC user or group

to the cluster. When you add another node to the cluster, you should reassign the RBAC user or group to

the cluster to include the new node for the RBAC user or group.

• If you are planning to replicate Snapshots, you must assign the storage connection for both the source and

destination volume to the user performing the operation.

You should add assets before assigning access to the users.
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If you are using the SnapCenter Plug-in for VMware vSphere functions to protect VMs, VMDKs,

or datastores, you should use the VMware vSphere GUI to add a vCenter user to a SnapCenter

Plug-in for VMware vSphere role. For information about VMware vSphere roles, see Predefined

roles packaged with SnapCenter Plug-in for VMware vSphere.

Steps

1. In the left navigation pane, click Settings.

2. In the Settings page, click Users and Access > .

3. In the Add Users/Groups from Active Directory or Workgroup page:

For this field… Do this…

Access Type Select either Domain or workgroup

For Domain authentication type, you should specify

the domain name of the user or group to which you

want to add the user to a role.

By default, it is pre-populated with the logged in

domain name.

You must register the untrusted

domain in the Settings > Global

Settings > Domain Settings page.

Type Select either User or Group

SnapCenter supports only security

group and not the distribution group.

User Name a. Type the partial user name, and then click Add.

The user name is case-sensitive.

b. Select the user name from the search list.

When you add users from a different

domain or an untrusted domain, you

should type the user name fully

because there is no search list for

cross domain users.

Repeat this step to add additional users or groups

to the selected role.

Roles Select the role to which you want to add the user.

4. Click Assign, and then in the Assign Assets page:
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a. Select the type of asset from the Asset drop-down list.

b. In the Asset table, select the asset.

The assets are listed only if the user has added the assets to SnapCenter.

c. Repeat this procedure for all of the required assets.

d. Click Save.

5. Click Submit.

After adding users or groups and assigning roles, refresh the resources list.

Configure audit log settings

Audit logs are generated for each and every activity of the SnapCenter Server. By default,

audit logs are secured in the default installed location C:\Program

Files\NetApp\SnapCenter WebApp\audit\.

Audit logs are secured by means of generating digitally signed digest for each and every audit events to

protect it from the unauthorized modification. The generated digest’s are maintained in the separate audit

checksum file and it under goes periodic integrity checks to ensure the integrity of the content.

You should have logged in as the "SnapCenterAdmin" role.

About this task

• Alerts are sent in the following scenarios:

◦ Audit log integrity check schedule or Syslog server is enabled or disabled

◦ Audit log integrity check, audit log, or Syslog server log failure

◦ Low disk space

• Email is sent only when integrity check fails.

• You should modify both audit log directory and audit checksum log directory paths together. You cannot

modify only one of them.

• When audit log directory and audit checksum log directory paths are modified, the integrity check cannot

be performed on audit logs present in the earlier location.

• Audit log directory and Audit checksum log directory paths should be on the local drive of SnapCenter

Server.

Shared or network mounted drives are not supported.

• If UDP protocol is used in the Syslog server settings, errors due to port is down or unavailable cannot be

captured as either an error or an alert in SnapCenter.

• You can use Set-SmAuditSettings and Get-SmAuditSettings commands to configure the audit logs.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer the SnapCenter Software

Cmdlet Reference Guide.

Steps

85

https://docs.netapp.com/us-en/snapcenter-cmdlets/index.html
https://docs.netapp.com/us-en/snapcenter-cmdlets/index.html


1. In the Settings page, navigate to Settings > Global Settings > Audit log Settings.

2. In the Audit log section, enter the details.

3. Enter the Audit log directory and Audit checksum log directory

a. Enter the Maximum file size

b. Enter the Maximum log files

c. Enter the percentage of disk space usage to send an alert

4. (Optional) Enable Log UTC time.

5. (Optional) Enable Audit Log Integrity Check Schedule and click Start Integrity Check for on demand

integrity check.

You can also run Start-SmAuditIntegrityCheck command to start on demand integrity check.

6. (Optional) Enable Forwarded audit logs to remote syslog server and enter the Syslog Server details.

You should import the certificate from the Syslog server into the 'Trusted Root' for TLS 1.2 protocol.

a. Enter Syslog Server Host

b. Enter Syslog Server Port

c. Enter Syslog Server Protocol

d. Enter RFC Format

7. Click Save.

8. You can see audit integrity checks and disk space checks by clicking Monitor > Jobs.

Configure secured MySQL connections with SnapCenter Server

You can generate Secure Sockets Layer (SSL) certificates and key files if you want to

secure the communication between SnapCenter Server and MySQL Server in standalone

configurations or Network Load Balancing (NLB) configurations.

Configure secured MySQL connections for standalone SnapCenter Server configurations

You can generate Secure Sockets Layer (SSL) certificates and key files, if you want to secure the

communication between SnapCenter Server and MySQL Server. You must configure the certificates and key

files in the MySQL Server and SnapCenter Server.

The following certificates are generated:

• CA certificate

• Server public certificate and private key file

• Client public certificate and private key file

Steps

1. Set up the SSL certificates and key files for MySQL servers and clients on Windows by using the openssl

command.

For information, see MySQL Version 5.7: Creating SSL Certificates and Keys Using openssl
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The common name value that is used for the server certificate, client certificate, and key

files must each differ from the common name value that is used for the CA certificate. If the

common name values are the same, the certificate and key files fail for servers that are

compiled by using OpenSSL.

Best Practice: You should use the server fully qualified domain name (FQDN) as the common name for

the server certificate.

2. Copy the SSL certificates and key files to the MySQL Data folder.

The default MySQL Data folder path is C:\ProgramData\NetApp\SnapCenter\MySQL Data\Data\.

3. Update the CA certificate, server public certificate, client public certificate, server private key, and client

private key paths in the MySQL server configuration file (my.ini).

The default MySQL server configuration file (my.ini) path is

C:\ProgramData\NetApp\SnapCenter\MySQL Data\my.ini.

You must specify the CA certificate, server public certificate, and server private key paths in

the [mysqld] section of the MySQL server configuration file (my.ini).

You must specify the CA certificate, client public certificate, and client private key paths in the [client]

section of the MySQL server configuration file (my.ini).

The following example shows the certificates and key files copied to the [mysqld] section of the my.ini file in

the default folder C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data.

ssl-ca="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/ca.pem"

ssl-cert="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/server-

cert.pem"

ssl-key="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/server-

key.pem"

The following example shows the paths updated in the [client] section of the my.ini file.

ssl-ca="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/ca.pem"

ssl-cert="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/client-

cert.pem"
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ssl-key="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/client-

key.pem"

4. Stop the SnapCenter Server web application in the Internet Information Server (IIS).

5. Restart the MySQL service.

6. Update the value of the MySQLProtocol key in the SnapManager.Web.UI.dll.config file.

The following example shows the value of the MySQLProtocol key updated in the

SnapManager.Web.UI.dll.config file.

<add key="MySQLProtocol" value="SSL" />

7. Update the SnapManager.Web.UI.dll.config file with the paths that were provided in the [client] section of

the my.ini file.

The following example shows the paths updated in the [client] section of the my.ini file.

<add key="ssl-client-cert" value="C:/ProgramData/NetApp/SnapCenter/MySQL

Data/Data/client-cert.pem" />

<add key="ssl-client-key" value="C:/ProgramData/NetApp/SnapCenter/MySQL

Data/Data/client-key.pem" />

<add key="ssl-ca" value="C:/ProgramData/NetApp/SnapCenter/MySQL

Data/Data/ca.pem" />

8. Start the SnapCenter Server web application in the IIS.

Configure secured MySQL connections for HA configurations

You can generate Secure Sockets Layer (SSL) certificates and key files for both the High Availability (HA)

nodes if you want to secure the communication between SnapCenter Server and MySQL servers. You must

configure the certificates and key files in the MySQL servers and on the HA nodes.

The following certificates are generated:

• CA certificate

A CA certificate is generated on one of the HA nodes, and this CA certificate is copied to the other HA

node.

• Server public certificate and server private key files for both the HA nodes

• Client public certificate and client private key files for both the HA nodes
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Steps

1. For the first HA node, set up the SSL certificates and key files for MySQL servers and clients on Windows

by using the openssl command.

For information, see MySQL Version 5.7: Creating SSL Certificates and Keys Using openssl

The common name value that is used for the server certificate, client certificate, and key

files must each differ from the common name value that is used for the CA certificate. If the

common name values are the same, the certificate and key files fail for servers that are

compiled by using OpenSSL.

Best Practice: You should use the server fully qualified domain name (FQDN) as the common name for

the server certificate.

2. Copy the SSL certificates and key files to the MySQL Data folder.

The default MySQL Data folder path is C:\ProgramData\NetApp\SnapCenter\MySQL Data\Data\.

3. Update the CA certificate, server public certificate, client public certificate, server private key, and client

private key paths in the MySQL server configuration file (my.ini).

The default MySQL server configuration file (my.ini) path is C:\ProgramData\NetApp\SnapCenter\MySQL

Data\my.ini.

You must specify CA certificate, server public certificate, and server private key paths in the

[mysqld] section of the MySQL server configuration file (my.ini).

You must specify CA certificate, client public certificate, and client private key paths in the [client] section of

the MySQL server configuration file (my.ini).

The following example shows the certificates and key files copied to the [mysqld] section of the my.ini file in

the default folder C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data.

ssl-ca="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/ca.pem"

ssl-cert="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/server-

cert.pem"

ssl-key="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/server-

key.pem"

The following example shows the paths updated in the [client] section of the my.ini file.

ssl-ca="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/ca.pem"
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ssl-cert="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/client-

cert.pem"

ssl-key="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/client-

key.pem"

4. For the second HA node, copy the CA certificate and generate server public certificate, server private key

files, client public certificate, and client private key files. perform the following steps:

a. Copy the CA certificate generated on the first HA node to the MySQL Data folder of the second NLB

node.

The default MySQL Data folder path is C:\ProgramData\NetApp\SnapCenter\MySQL Data\Data\.

You must not create a CA certificate again. You should create only the server public

certificate, client public certificate, server private key file, and client private key file.

b. For the first HA node, set up the SSL certificates and key files for MySQL servers and clients on

Windows by using the openssl command.

MySQL Version 5.7: Creating SSL Certificates and Keys Using openssl

The common name value that is used for the server certificate, client certificate, and key

files must each differ from the common name value that is used for the CA certificate. If

the common name values are the same, the certificate and key files fail for servers that

are compiled by using OpenSSL.

It is recommended to use the server FQDN as the common name for the server certificate.

c. Copy the SSL certificates and key files to the MySQL Data folder.

d. Update the CA certificate, server public certificate, client public certificate, server private key, and client

private key paths in the MySQL server configuration file (my.ini).

You must specify the CA certificate, server public certificate, and server private key

paths in the [mysqld] section of the MySQL server configuration file (my.ini).

You must specify the CA certificate, client public certificate, and client private key paths in the [client]

section of the MySQL server configuration file (my.ini).

The following example shows the certificates and key files copied to the [mysqld] section of the my.ini

file in the default folder C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data.

ssl-ca="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/ca.pem"
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ssl-cert="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/server-

cert.pem"

ssl-key="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/server-

key.pem"

The following example shows the paths updated in the [client] section of the my.ini file.

ssl-ca="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/ca.pem"

ssl-cert="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/server-

cert.pem"

ssl-key="C:/ProgramData/NetApp/SnapCenter/MySQL Data/Data/server-

key.pem"

5. Stop the SnapCenter Server web application in the Internet Information Server (IIS) on both the HA nodes.

6. Restart the MySQL service on both the HA nodes.

7. Update the value of the MySQLProtocol key in the SnapManager.Web.UI.dll.config file for both the HA

nodes.

The following example shows the value of MySQLProtocol key updated in the

SnapManager.Web.UI.dll.config file.

<add key="MySQLProtocol" value="SSL" />

8. Update the SnapManager.Web.UI.dll.config file with the paths that you specified in the [client] section of the

my.ini file for both the HA nodes.

The following example shows the paths updated in the [client] section of the my.ini files.

<add key="ssl-client-cert" value="C:/ProgramData/NetApp/SnapCenter/MySQL

Data/Data/client-cert.pem" />

<add key="ssl-client-key" value="C:/ProgramData/NetApp/SnapCenter/MySQL

Data/Data/client-key.pem" />
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<add key="ssl-ca" value="C:/ProgramData/NetApp/SnapCenter/MySQL

Data/Data/ca.pem" />

9. Start the SnapCenter Server web application in the IIS on both the HA nodes.

10. Use the Set-SmRepositoryConfig -RebuildSlave -Force PowerShell cmdlet with the -Force option on one of

the HA nodes to establish secured MySQL replication on both the HA nodes.

Even if the replication status is healthy, the -Force option allows you to rebuild the slave repository.

Configure Certificate-based authentication

Certificate-based authentication enhances security by verifying the identity of both the

SnapCenter Server and plug-in hosts, ensuring secure and encrypted communication.

Enable Certificate-based authentication

To enable certificate-based authentication for SnapCenter Server and the Windows plug-in hosts, run the

following PowerShell cmdlet. For the Linux plug-in hosts, the certificate-based authentication will be enabled

when you enable the two-way SSL.

• To enable client certificate-based authentication:

Set-SmConfigSettings -Agent –configSettings

@{"EnableClientCertificateAuthentication"="true"} -HostName [hostname]

• To disable client certificate-based authentication:

Set-SmConfigSettings -Agent –configSettings

@{"EnableClientCertificateAuthentication"="false"} -HostName [hostname]`

Export Certificate Authority (CA) certificates from SnapCenter Server

You should export the CA certificates from the SnapCenter Server to the plug-in hosts using the Microsoft

management console (MMC).

Before you begin

You should have configured the two-way SSL.

Steps

1. Go to the Microsoft management console (MMC), and then click File > Add/Remove Snapin.

2. In the Add or Remove Snap-ins window, select Certificates and then click Add.

3. In the Certificates Snap-in window, select the Computer Account option, and then click Finish.

4. Click Console Root > Certificates - Local Computer > Personal > Certificates.

5. Right-click on the procured CA certificate, which is used for SnapCenter Server and then select All Tasks

> Export to start the export wizard.

6. Perform the following actions in the wizard.
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For this option… Do the following…

Export Private Key Select No, do not export the private key, and then

click Next.

Export File Format Click Next.

File Name Click Browse and specify the file path to save the

certificate, and click Next.

Completing the Certificate Export Wizard Review the summary, and then click Finish to start

the export.

Certificate based authentication is not supported for SnapCenter HA configurations and

SnapCenter Plug-in for VMware vSphere.

Import CA certificate to the Windows plug-in hosts

To use the exported SnapCenter Server CA certificate, you should import the related certificate to the

SnapCenter Windows plug-in hosts using the Microsoft management console (MMC).

Steps

1. Go to the Microsoft management console (MMC), and then click File > Add/Remove Snapin.

2. In the Add or Remove Snap-ins window, select Certificates and then click Add.

3. In the Certificates Snap-in window, select the Computer Account option, and then click Finish.

4. Click Console Root > Certificates - Local Computer > Personal > Certificates.

5. Right-click on the folder “Personal”, and then select All Tasks > Import to start the import wizard.

6. Perform the following actions in the wizard.

For this option… Do the following…

Store Location Click Next.

File to Import Select the SnapCenter Server certificate that ends

with .cer extension.

Certificate Store Click Next.

Completing the Certificate Export Wizard Review the summary, and then click Finish to start

the import.

Import CA Certificate to the UNIX plug-in hosts

You should import the CA certificate to the UNIX plug-in hosts.

About this task
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• You can manage the password for SPL keystore, and the alias of the CA signed key pair in use.

• The password for SPL keystore and for all the associated alias password of the private key should be

same.

Steps

1. You can retrieve SPL keystore default password from SPL property file. It is the value corresponding to the

key SPL_KEYSTORE_PASS.

2. Change the keystore password: $ keytool -storepasswd -keystore keystore.jks

3. Change the password for all aliases of private key entries in the keystore to the same password used for

the keystore: $ keytool -keypasswd -alias "<alias_name>" -keystore keystore.jks

4. Update the same for the key SPL_KEYSTORE_PASS in spl.properties` file.

5. Restart the service after changing the password.

Configure root or intermediate certificates to SPL trust-store

You should configure the root or intermediate certificates to SPL trust-store. You should add the root CA

certificate and then the intermediate CA certificates.

Steps

1. Navigate to the folder containing the SPL keystore: /var/opt/snapcenter/spl/etc.

2. Locate the file keystore.jks.

3. List the added certificates in the keystore: $ keytool -list -v -keystore keystore.jks

4. Add a root or intermediate certificate: $ keytool -import -trustcacerts -alias

<AliasNameForCerticateToBeImported> -file /<CertificatePath> -keystore

keystore.jks

5. Restart the service after configuring the root or intermediate certificates to SPL trust-store.

Configure CA signed key pair to SPL trust-store

You should configure the CA signed key pair to SPL trust-store.

Steps

1. Navigate to the folder containing the SPL’s keystore /var/opt/snapcenter/spl/etc.

2. Locate the file keystore.jks`.

3. List the added certificates in the keystore: $ keytool -list -v -keystore keystore.jks

4. Add the CA certificate having both private and public key. $ keytool -importkeystore

-srckeystore <CertificatePathToImport> -srcstoretype pkcs12 -destkeystore

keystore.jks -deststoretype JKS

5. List the added certificates in the keystore. $ keytool -list -v -keystore keystore.jks

6. Verify that the keystore contains the alias corresponding to the new CA certificate, which was added to the

keystore.

7. Change the added private key password for CA certificate to the keystore password.
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Default SPL keystore password is the value of the key SPL_KEYSTORE_PASS in spl.properties file.

$ keytool -keypasswd -alias "<aliasNameOfAddedCertInKeystore>" -keystore

keystore.jks`

8. If the alias name in the CA certificate is long and contains space or special characters ("*",","), change the

alias name to a simple name: $ keytool -changealias -alias "<OrignalAliasName>"

-destalias "<NewAliasName>" -keystore keystore.jks`

9. Configure the alias name from the keystore located in spl.properties file. Update this value against the

key SPL_CERTIFICATE_ALIAS.

10. Restart the service after configuring the CA signed key pair to SPL trust-store.

Export SnapCenter certificates

You should export the SnapCenter certificates in .pfx format.

Steps

1. Go to the Microsoft management console (MMC), and then click File > Add/Remove Snap-in.

2. In the Add or Remove Snap-ins window, select Certificates and then click Add.

3. In the Certificates snap-in window, select the My user account option, and then click Finish.

4. Click Console Root > Certificates - Current User > Trusted Root Certification Authorities >

Certificates.

5. Right-click the certificate that has the SnapCenter Friendly Name, and then select All Tasks > Export to

start the export wizard.

6. Complete the wizard, as follows:

In this wizard window… Do the following…

Export Private Key Select the option Yes, export the private key, and

then click Next.

Export File Format Make no changes; click Next.

Security Specify the new password to be used for the

exported certificate, and then click Next.

File to Export Specify a file name for the exported certificate (you

must use .pfx), and then click Next.

Completing the Certificate Export Wizard Review the summary, and then click Finish to start

the export.

Configure CA Certificate for Windows host
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Generate CA Certificate CSR file

You can generate a Certificate Signing Request (CSR) and import the certificate that can

be obtained from a Certificate Authority (CA) using the generated CSR. The certificate will

have a private key associated with it.

CSR is a block of encoded text that is given to an authorized certificate vendor to procure the signed CA

certificate.

CA Certificate RSA key length must be minimum 3072 bits.

For information to generate a CSR, see How to generate CA Certificate CSR file.

If you own the CA certificate for your domain (*.domain.company.com) or your system

(machine1.domain.company.com), you can skip generating the CA Certificate CSR file. You can

deploy the existing CA certificate with SnapCenter.

For cluster configurations, the cluster name (virtual cluster FQDN), and the respective host names should be

mentioned in the CA certificate. The certificate can be updated by filling the Subject Alternative Name (SAN)

field before procuring the certificate. For a wild card certificate (*.domain.company.com), the certificate will

contain all the hostnames of the domain implicitly.

Import CA certificates

You must import the CA certificates to the SnapCenter Server and the Windows host

plug-ins using the Microsoft management console (MMC).

Steps

1. Go to the Microsoft management console (MMC), and then click File > Add/Remove Snapin.

2. In the Add or Remove Snap-ins window, select Certificates and then click Add.

3. In the Certificates snap-in window, select the Computer account option, and then click Finish.

4. Click Console Root > Certificates – Local Computer > Trusted Root Certification Authorities >

Certificates.

5. Right-click on the folder “Trusted Root Certification Authorities”, and then select All Tasks > Import to start

the import wizard.

6. Complete the wizard, as follows:

In this wizard window… Do the following…

Import Private Key Select the option Yes, import the private key, and

then click Next.

Import File Format Make no changes; click Next.

Security Specify the new password to be used for the

exported certificate, and then click Next.
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In this wizard window… Do the following…

Completing the Certificate Import Wizard Review the summary, and then click Finish to start

the import.

Importing certificate should be bundled with the private key (supported formats are: *.pfx,

*.p12, and *.p7b).

7. Repeat Step 5 for the “Personal” folder.

Get the CA certificate thumbprint

A certificate thumbprint is a hexadecimal string that identifies a certificate. A thumbprint is

calculated from the content of the certificate using a thumbprint algorithm.

Steps

1. Perform the following on the GUI:

a. Double-click the certificate.

b. In the Certificate dialog box, click the Details tab.

c. Scroll through the list of fields and click Thumbprint.

d. Copy the hexadecimal characters from the box.

e. Remove the spaces between the hexadecimal numbers.

For example, if the thumbprint is: "a9 09 50 2d d8 2a e4 14 33 e6 f8 38 86 b0 0d 42 77 a3 2a 7b", after

removing the spaces, it will be: "a909502dd82ae41433e6f83886b00d4277a32a7b".

2. Perform the following from PowerShell:

a. Run the following command to list the thumbprint of the installed certificate and identify the recently

installed certificate by the subject name.

Get-ChildItem -Path Cert:\LocalMachine\My

b. Copy the thumbprint.

Configure CA certificate with Windows host plug-in services

You should configure the CA certificate with Windows host plug-in services to activate the

installed digital certificate.

Perform the following steps on the SnapCenter Server and all the plug-in hosts where CA certificates are

already deployed.

Steps

1. Remove the existing certificate binding with SMCore default port 8145, by running the following command:

> netsh http delete sslcert ipport=0.0.0.0:_<SMCore Port>

For example:
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> netsh http delete sslcert ipport=0.0.0.0:8145

2. Bind the newly installed certificate with the Windows host plug-in services, by running the following

commands:

> $cert = “_<certificate thumbprint>_”

> $guid = [guid]::NewGuid().ToString("B")

> netsh http add sslcert ipport=0.0.0.0: _<SMCore Port>_ certhash=$cert

appid="$guid"

For example:

> $cert = “a909502dd82ae41433e6f83886b00d4277a32a7b”

> $guid = [guid]::NewGuid().ToString("B")

> netsh http add sslcert ipport=0.0.0.0: _<SMCore Port>_ certhash=$cert

appid="$guid"

Configure CA certificate with SnapCenter site

You should configure the CA certificate with SnapCenter site on Windows host.

Steps

1. Open IIS Manager on the Windows Server where SnapCenter is installed.

2. In the left navigation pane, click Connections.

3. Expand the name of the server and Sites.

4. Select the SnapCenter website on which you want to install the SSL Certificate.

5. Navigate to Actions > Edit Site, click Bindings.

6. In the Bindings page, select binding for https.

7. Click Edit.

8. From the SSL certificate drop-down list, select the recently imported SSL Certificate.

9. Click OK.

The SnapCenter Scheduler site (default port: 8154, HTTPS) is configured with self-signed

certificate. This port is communicating within the SnapCenter Server host and it is not

mandatory to configure with a CA certificate. However, if your environment mandates you to

use a CA Certificate, repeat steps 5 to 9 using the SnapCenter Scheduler site.

If the recently deployed CA certificate is not listed in the drop-down menu, check if the CA

certificate is associated with the private key.
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Ensure that the certificate is added using the following path: Console Root > Certificates –

Local Computer > Trusted Root Certification Authorities > Certificates.

Enable CA certificates for SnapCenter

You should configure the CA certificates and enable the CA certificate validation for the

SnapCenter Server.

Before you begin

• You can enable or disable the CA certificates using the Set-SmCertificateSettings cmdlet.

• You can display the certificate status for the SnapCenter Server using the Get-SmCertificateSettings

cmdlet.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can refer to the SnapCenter Software

Cmdlet Reference Guide.

Steps

1. In the Settings page, navigate to Settings > Global Settings > CA Certificate Settings.

2. Select Enable Certificate Validation.

3. Click Apply.

After you finish

The Managed Hosts tab host displays a padlock and the color of the padlock indicates the status of the

connection between SnapCenter Server and the plug-in host.

•  indicates that there is no CA certificate enabled or assigned to the plug-in host.

•  indicates that the CA certificate is successfully validated.

•  indicates that the CA certificate could not be validated.

•  indicates that the connection information could not be retrieved.

When the status is yellow or green, the data protection operations completes successfully.

Configure CA Certificate for Linux host

After installing the SnapCenter Server on Linux, the installer creates the self-signed

certificate. If you want to use the CA certificate, you should configure the certificates for

nginx reverse proxy, audit logging, and SnapCenter.

Configure nginx certificate

Steps

1. Navigate to /etc/nginx/conf.d: cd /etc/nginx/conf.d

2. Open snapcenter.conf using vi or any text editor.

3. Navigate to the server section in the configuration file.
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4. Modify the paths of ssl_certificate and ssl_certificate_key to point to CA certificate.

5. Save and close the file.

6. Reload nginx: $nginx -s reload

Configure audit log certificate

Steps

1. Open INSTALL_DIR/NetApp/snapcenter/SnapManagerWeb/SnapManager.Web.UI.dll.config using vi or

any text editor.

The default value of INSTALL_DIR is /opt.

2. Edit the AUDILOG_CERTIFICATE_PATH and AUDILOG_CERTIFICATE_PASSWORD keys to include the

CA certificate path and password respectively.

Only .pfx format is supported for audit log certificate.

3. Save and close the file.

4. Restart the snapmanagerweb service: $ systemctl restart snapmanagerweb

Configure SnapCenter certificate

Steps

1. Open the following configuration files using using vi or any text editor.

◦ INSTALL_DIR/NetApp/snapcenter/SnapManagerWeb/SnapManager.Web.UI.dll.config

◦ INSTALL_DIR/NetApp/snapcenter/SMCore/SMCoreServiceHost.dll.config

◦ INSTALL_DIR/NetApp/snapcenter/Scheduler/Scheduler.Api.dll.config

The default value of INSTALL_DIR is /opt.

2. Edit the SERVICE_CERTIFICATE_PATH and SERVICE_CERTIFICATE_PASSWORD keys to include the

CA certificate path and password respectively.

Only .pfx format is supported for SnapCenter certificate.

3. Save and close the files.

4. Restart all the services.

◦ $ systemctl restart snapmanagerweb

◦ $ systemctl restart smcore

◦ $ systemctl restart scheduler

Configure and enable two-way SSL communication on
Windows host

Configure two-way SSL communication on Windows host

You should configure the two-way SSL communication to secure the mutual
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communication between SnapCenter Server on Windows host and the plug-ins.

Before you begin

• You should have generated the CA Certificate CSR file with the minimum supported key length of 3072.

• The CA certificate should support server authentication and client authentication.

• You should have a CA certificate with private key and thumbprint details.

• You should have enabled the one-way SSL configuration.

For more details, see Configure CA certificate section.

• You must have enabled two-way SSL communication on all the plug-in hosts and the SnapCenter Server.

Environment with some hosts or server not enabled for two-way SSL communication is not supported.

Steps

1. To bind the port, perform the following steps on SnapCenter Server host for SnapCenter IIS web server

port 8146 (default) and once again for SMCore port 8145 (default) using PowerShell commands.

a. Remove the existing SnapCenter self-signed certificate port binding using the following PowerShell

command.

> netsh http delete sslcert ipport=0.0.0.0:<SMCore port/IIS port>

For example,

> netsh http delete sslcert ipport=0.0.0.0:8145

> netsh http delete sslcert ipport=0.0.0.0:8146

b. Bind the newly procured CA certificate with the SnapCenter server and SMCore port.

> $cert = “<CA_certificate thumbprint>”

> $guid = [guid]::NewGuid().ToString("B")

> netsh http add sslcert ipport=0.0.0.0: <SMCore Port/IIS port>

certhash=$cert appid="$guid" clientcertnegotiation=enable

verifyclientcertrevocation=disable

> netsh http show sslcert ipport=0.0.0.0:<SMCore Port/IIS port>

For example,

> $cert = “abc123abc123abc123abc123”

> $guid = [guid]::NewGuid().ToString("B")

> netsh http add sslcert ipport=0.0.0.0:8146 certhash=$cert appid="$guid"

clientcertnegotiation=enable verifyclientcertrevocation=disable

> $guid = [guid]::NewGuid().ToString("B")
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> netsh http add sslcert ipport=0.0.0.0:8145 certhash=$cert appid="$guid"

clientcertnegotiation=enable verifyclientcertrevocation=disable

> netsh http show sslcert ipport=0.0.0.0:8146

> netsh http show sslcert ipport=0.0.0.0:8145

2. To access permission to the CA certificate, add the SnapCenter’s default IIS web server user "IIS

AppPool\SnapCenter" in the certificate permission list by performing the following steps to access the

newly procured CA certificate.

a. Go to the Microsoft management console (MMC), and then click File > Add/Remove SnapIn.

b. In the Add or Remove Snap-ins window, select Certificates and then click Add.

c. In the Certificates snap-in window, select the Computer account option, and then click Finish.

d. Click Console Root > Certificates – Local Computer > Personal > Certificates.

e. Select the SnapCenter certificate.

f. To start the add user\permission wizard, right-click on the CA certificate and select All Tasks >

Manage private keys.

g. Click on Add, on Select users and groups wizard change the location to local computer name (top

most in the hierarchy)

h. Add the IIS AppPool\SnapCenter user, give full control permissions.

3. For CA certificate IIS permission, add the new DWORD registry keys entry in SnapCenter Server from

the following path:

In the windows registry editor, traverse to the below mentioned path,

HKey_Local_Machine\SYSTEM\CurrentControlSet\Control\SecurityProv ders\SCHANNEL

4. Create new DWORD registry key entry under the context of SCHANNEL registry configuration.

SendTrustedIssuerList = 0

ClientAuthTrustMode = 2

Configure SnapCenter Windows plug-in for Two-way SSL communication

You should configure SnapCenter Windows plug-in for two-way SSL communication using PowerShell

commands.

Before you begin

Ensure that the CA certificate thumbprint is available.

Steps

1. To bind the port, perform the following actions on Windows plug-in host for SMCore port 8145 (default).

a. Remove the existing SnapCenter self-signed certificate port binding using the following PowerShell

command.

> netsh http delete sslcert ipport=0.0.0.0:<SMCore port>

For example,
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> netsh http delete sslcert ipport=0.0.0.0:8145

b. Bind the newly procured CA certificate with the SMCore port.

> $cert = “<CA_certificate thumbprint>”

> $guid = [guid]::NewGuid().ToString("B")

> netsh http add sslcert ipport=0.0.0.0: <SMCore Port> certhash=$cert

appid="$guid" clientcertnegotiation=enable

verifyclientcertrevocation=disable

> netsh http show sslcert ipport=0.0.0.0:<SMCore Port>

For example,

> $cert = “abc123abc123abc123abc123”

> $guid = [guid]::NewGuid().ToString("B")

> netsh http add sslcert ipport=0.0.0.0:8145 certhash=$cert appid="$guid"

clientcertnegotiation=enable verifyclientcertrevocation=disable

> netsh http show sslcert ipport=0.0.0.0:8145

Enable two-way SSL communication on Windows host

You can enable two-way SSL communication to secure the mutual communication

between SnapCenter Server on Windows host and the plug-ins using PowerShell

commands.

Before you begin

Execute the commands for all the plug-ins and the SMCore agent first and then for server.

Steps

1. To enable the two-way SSL communication, run the following commands on the SnapCenter Server for the

plug-ins, server, and for each of the agents for which the two-way SSL communication is required.

> Set-SmConfigSettings -Agent -configSettings @{"EnableTwoWaySSL"="true"}

-HostName <Plugin_HostName>

> Set-SmConfigSettings -Agent -configSettings @{"EnableTwoWaySSL"="true"}

-HostName localhost

> Set-SmConfigSettings -Server -configSettings @{"EnableTwoWaySSL"="true"}

2. Perform the IIS SnapCenter Application pool recycle operation by using the following command. >

Restart-WebAppPool -Name "SnapCenter"

3. For Windows plug-ins, restart the SMCore service by running the following PowerShell command:
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> Restart-Service -Name SnapManagerCoreService

Disable two-way SSL Communication

You can disable the two-way SSL communication using PowerShell commands.

About this task

• Execute the commands for all the plug-ins and the SMCore agent first and then for server.

• When you disable the two-way SSL communication, the CA certificate and its configuration are not

removed.

• To add a new host to SnapCenter Server, you must disable the two-way SSL for all plug-in hosts.

• NLB and F5 are not supported.

Steps

1. To disable the two-way SSL communication, run the following commands on SnapCenter Server for all the

plug-in hosts and the SnapCenter host.

> Set-SmConfigSettings -Agent -configSettings @{"EnableTwoWaySSL"="false"}

-HostName <Agent_HostName>

> Set-SmConfigSettings -Agent -configSettings @{"EnableTwoWaySSL"="false"}

-HostName localhost

> Set-SmConfigSettings -Server -configSettings @{"EnableTwoWaySSL"="false"}

2. Perform the IIS SnapCenter Application pool recycle operation by using the following command. >

Restart-WebAppPool -Name "SnapCenter"

3. For Windows plug-ins, restart the SMCore service by running the following PowerShell command:

> Restart-Service -Name SnapManagerCoreService

Configure and enable two-way SSL communication on
Linux host

Configure two-way SSL communication on Linux host

You should configure the two-way SSL communication to secure the mutual

communication between SnapCenter Server on Linux host and the plug-ins.

Before you begin

• You should have configured the CA certificate for Linux host.

• You must have enabled two-way SSL communication on all the plug-in hosts and the SnapCenter Server.

Steps

1. Copy certificate.pem to /etc/pki/ca-trust/source/anchors/.

2. Add the certificates in the trust list of your Linux host.

104



◦ cp root-ca.pem /etc/pki/ca-trust/source/anchors/

◦ cp certificate.pem /etc/pki/ca-trust/source/anchors/

◦ update-ca-trust extract

3. Verify if the certificates were added to the trust list. trust list | grep "<CN of your

certificate>"

4. Update ssl_certificate and ssl_certificate_key in the SnapCenter nginx file and restart.

◦ vim /etc/nginx/conf.d/snapcenter.conf

◦ systemctl restart nginx

5. Refresh the SnapCenter Server GUI link.

6. Update the values of the following keys in SnapManager.Web.UI.dll.config located at _ /<installation

path>/NetApp/snapcenter/SnapManagerWeb_ and SMCoreServiceHost.dll.config located at

/<installation path>/NetApp/snapcenter/SMCore.

◦ <add key="SERVICE_CERTIFICATE_PATH" value="<path of certificate.pfx>" />

◦ <add key="SERVICE_CERTIFICATE_PASSWORD" value="<password>"/>

7. Restart the following services.

◦ systemctl restart smcore.service

◦ systemctl restart snapmanagerweb.service

8. Verify that the certificate is attached to the SnapManager web port. openssl s_client -connect

localhost:8146 -brief

9. Verify that the certificate is attached to the smcore port. openssl s_client -connect

localhost:8145 -brief

10. Manage password for SPL keystore and alias.

a. Retrieve SPL keystore default password assigned to the SPL_KEYSTORE_PASS key in SPL property

file.

b. Change the keystore password. keytool -storepasswd -keystore keystore.jks

c. Change the password for all the aliases of private key entries. keytool -keypasswd -alias

"<alias_name>" -keystore keystore.jks

d. Update the same password for the key SPL_KEYSTORE_PASS in spl.properties.

e. Restart the service.

11. On plug-in Linux host, add the root and intermediate certificates in SPL plug-in’s keystore.

◦ keytool -import -trustcacerts -alias <any preferred alias name> -file <path

of root-ca.pem> -keystore <path of keystore.jks mentioned in spl.properties

file>

◦ keytool -importkeystore -srckeystore <path of certificate.pfx> -srcstoretype

pkcs12 -destkeystore <path of keystore.jks mentioned in spl.properties file>

-deststoretype JKS

a. Check the entries in keystore.jks. keytool -list -v -keystore <path to

keystore.jks>

b. Rename any alias if required. keytool -changealias -alias "old-alias" -destalias
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"new-alias" -keypass keypass -keystore </path/to/keystore> -storepass

storepas

12. Update the value of SPL_CERTIFICATE_ALIAS in spl.properties file with the alias of certificate.pfx

stored in keystore.jks and restart the SPL service: systemctl restart spl

13. Verify that the certificate is attached to the smcore port. openssl s_client -connect

localhost:8145 -brief

Enable SSL communication on Linux host

You can enable two-way SSL communication to secure the mutual communication

between SnapCenter Server on Linux host and the plug-ins using PowerShell

commands.

Step

1. Perform the following to enable one-way SSL communication.

a. Log into SnapCenter GUI.

b. Click Settings > Global Settings and select Enable certificate validation on SnapCenter Server.

c. Click Hosts > Managed Hosts and select the plug-in host for which you want to enable one-way SSL.

d.
Click  icon, and then click Enable certificate validation.

2. Enable two-way SSL communication from the SnapCenter Server Linux host.

◦ Open-SmConnection

◦ Set-SmConfigSettings -Agent -configSettings @{"EnableTwoWaySSL"="true"}

-HostName <Plugin Host Name>

◦ Set-SmConfigSettings -Agent -configSettings @{"EnableTwoWaySSL"="true"}

-HostName localhost

◦ Set-SmConfigSettings -Server -configSettings @{"EnableTwoWaySSL"="true"}

Configure Active Directory, LDAP, and LDAPS

Register untrusted Active Directory domains

You should register the Active Directory with SnapCenter Server to manage hosts, users,

and groups from multiple untrusted Active Directory domains.

Before you begin

LDAP and LDAPS protocols

• You can register the untrusted active directory domains using either LDAP or LDAPS protocol.

• You should have enabled bidirectional communication between the plug-in hosts and the SnapCenter

Server.

• DNS resolution should be set up from the SnapCenter Server to the plug-in hosts and vice-versa.

LDAP protocol
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• The fully qualified domain name (FQDN) should be resolvable from SnapCenter Server.

You can register an untrusted domain with the FQDN. If the FQDN is not resolvable from the SnapCenter

Server, you can register with a domain controller IP address and this should be resolvable from

SnapCenter Server.

LDAPS protocol

• CA certificates are required for LDAPS to provide end-to-end encryption during the active directory

communication.

Configure CA client certificate for LDAPS

• Domain controller host names (DCHostName) should be reachable from SnapCenter Server.

About this task

• You can use either the SnapCenter user interface, PowerShell cmdlets, or REST API to register an

untrusted domain.

Steps

1. In the left navigation pane, click Settings.

2. In the Settings page, click Global Settings..

3. In the Global Settings page, click Domain Settings.

4.
Click  to register a new domain.

5. In the Register New Domain page, select either LDAP or LDAPS.

a. If you select LDAP, specify the information that is required for registering the untrusted domain for

LDAP:

For this field… Do this…

Domain Name Specify the NetBIOS name for the domain.

Domain FQDN Specify the FQDN and click Resolve.

Domain controller IP addresses If the domain FQDN is not resolvable from the

SnapCenter Server, specify one or more domain

controller IP addresses.

For more information, see Add domain controller

IP for untrusted domain from GUI.

b. If you select LDAPS, specify the information that is required for registering the untrusted domain for

LDAPS:

For this field… Do this…

Domain Name Specify the NetBIOS name for the domain.
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For this field… Do this…

Domain FQDN Specify the FQDN.

Domain controller Names Specify one or more domain controller names and

click Resolve.

Domain controller IP addresses If the domain controller names is not resolvable

from SnapCenter Server, you should rectify the

DNS resolutions.

6. Click OK.

Configure IIS Application Pools to enable Active Directory read permissions

You can configure Internet Information Services (IIS) on your Windows Server to create a

custom Application Pool account when you need to enable Active Directory read

permissions for SnapCenter.

Steps

1. Open IIS Manager on the Windows Server where SnapCenter is installed.

2. In the left navigation pane, click Application Pools.

3. Select SnapCenter in the Application Pools list, and then click Advanced Settings in the Actions pane.

4. Select Identity, and then click … to edit the SnapCenter application pool identity.

5. In the Custom Account field, enter a domain user or domain admin account name with Active Directory

read permission.

6. Click OK.

The custom account replaces the built-in ApplicationPoolIdentity account for the SnapCenter application

pool.

Configure CA client certificate for LDAPS

You should configure the CA client certificate for LDAPS on the SnapCenter Server when

the Windows Active Directory LDAPS is configured with the CA certificates.

Steps

1. Go to the Microsoft management console (MMC), and then click File > Add/Remove Snapin.

2. In the Add or Remove Snap-ins window, select Certificates and then click Add.

3. In the Certificates snap-in window, select the Computer account option, and then click Finish.

4. Click Console Root > Certificates – Local Computer > Trusted Root Certification Authorities >

Certificates.

5. Right-click on the folder “Trusted Root Certification Authorities”, and then select All Tasks > Import to start

the import wizard.
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6. Complete the wizard, as follows:

In this wizard window… Do the following…

In the second page of the wizard Click Browse, select the Root Certificate and click

Next.

Completing the Certificate Import Wizard Review the summary, and then click Finish to start

the import.

7. Repeat Steps 5 and 6 for the intermediate certificates.
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